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BlueTile
(STEVAL-BCN002V1)

- Training Material Check/Installation Help
 ARM® Keil MDK Installation

* Introduction to Bluetooth® Low Energy

* BlueTile Development Kit

- ARM® Keil MDK License Installation

- Lab 1: Getting Started with BlueTile “Serial Terminal Test”
 Lab 2: Connecting to the ST BLE Sensor app

 Lab 3: LED characteristic

 Lab 4: Accelerometer embedded events detection

- Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion

* Lab 6: Cloud data logging on IBM Watson

- Lab 7: Bonus — Voice over BLE

Agenda

WiFi Network: STMicro
Password: STMTTT19



BlueTile (STEVAL-BCNO002V1B

: 0203
* LSMsDSD

* LPSp2hy

o Lisohoy

* VIS 7x

* HiTs221

* MP340T05TR
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On st.com
hitp://www.st.com/bluetile

m

nglish

§

Contact Us
,I Producls ~  Search.
lit=.augmented

I Products P Applications ¥ Tools & Software

Support & Community & Login

Evaluation Tools: > Splltion Evaluation Toals > Sensor Sclution Eval Boards > STEVAL-BCNOO2V1B >

STEVAL-BCNOO2V1B & Prnt

A savetomysT Share via Email

This product is in stock in our
BlueTile - Biuetooih LE enabled sensor node development kit estore

S| Download databrief

Overview Tools & Software Resources Quality & Reliability

The STEVAL-BCN0O02V1B Bluetooth LE enabled sensor node development kit features the STEVAL-
BCN002V1 multi-sensor board based on BlueNRG-2 SoC Bluetooth Low Energy application processor.
This sensor board has accelerometer, gyroscope, magnetometer, pressure, humidity, Time-of-Flight and

r microphone sensors, and is powered by a common CR2032 coin battery.

The sensor board communicates with a Bluetooth LE
life.augmented



BlueTile SDK

ttp://www.st.com/bluetile

Contact Us. English
lite.augmented

Products P Applications § Tools & Software About ST i L Support & Community & Login

Evaluation Tools > Soluiion Evaluation Tools > Sensor Solution Eval Boards > STEVAL-BCNOO2ZVAE >

STEVAL-BCNQOO2V1B : = Pont M Save toMyST Share via Email

S Oftw a re This product is in stock in our
BlueTile - Bluetooth LE enabled sensor node development kit e-store
Development 7S ars b
K 1 t

Overview Tools & Software Resources Quality & Reliability

Quick links

Evaluation Tool Software Wireless Connectivity Software

Embedded Software

EVALUATION TOOL SOFTWARE >

‘ " WIRELESS CONNECTIVITY SOFTWARE ¥

lite.augmented



BlueTile SDK

https://www.st.com/content/st com/en/products/embedded-software/evaluation-
tool-software/stsw-bluetile-dk.html

STSW-BLUETILE-DK = Pt M Saveto MyST Share via Email

Software development kit for the BlueTile, including sensor data sireaming over BLE, HID peripheral, Beacon, ett

Get Software Download databrief

Overview Tools & Software Resources

The STSW-BLUETILE-DK is based on STSW-BLUENRG1-DK evaluation SW package.

The STSW-BLUENRG1-DK package supports the
BlueNRG-1 and BlueNRG-2 Bluetocth Low-Energy

system-on-chip. This package includes a Wizard PC
ey HaL | ciyptoiin | Bk application to automatically generate the configuration
header file needed for the BLE radie initialization. This
package also includes BlueNRG-1 and BlueNRG-2

Drivers BiLONRG-2 Penpherals

- peripheral drivers and related examples, the BLE

firmware stack together with the HAL (Hardware
VLEILIX LISZMDL |  LPS2ZHH

Abstraction Layer) and CryptoLib (Cryptographic

‘ HW Components | SIUeNRG-2 tie
v/ N— - Lirary)
g : e el v The STSW-BLUETILE-DK supports the BlueTile

nlatfarm Thic narkana aviands QTSN R | IDNBE1 MW




On st.com

hitp://www.st.com/bluetile

Products [ Applications ¥ Tools & Software e Sa 2 & E Support & Community L Login

Evaluafion Tools > Soiufion Evaluafion Tools > Sensor Solufion Eval Boards > STEVAL-BCNOO2VIB >

1 STEVAL-BCNO02V1B & Print @ SaveioMysT B3 Share via Ema
S c h e m at I c | ) o . u This product is in stock in our

e-slore

Gerbe rs Bl Download databrief
BOM

Overview Tools & Software Resources Quality & Reliability

Quick links

kManufactunng Speciications
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Companion ST BLE Sensor app mm

e

ON YOUR PHONE

- Look for “ST BLE Sensor” on the App Store or Google Play

# Download on the

S App Store

|

GET ITON

' Google Play

&7,




Where to get it mm=

Sample & Buy

Part Number Marketing Budgetary Quantity Core Product ECCN Country Order from Distributors Order from ST

= Status Price [USS) (uUs) of Origin

STEVAL- CTIVE b0.0 1 BlueNRG-2, BALF-NRG- gA992C ITALY B Check Availability =7 Buy direct
BCNOCE2ZVIB 6203, LSMeDS50,

LIS2MDL, VL5311X,
MPI4ETOSTR-A,
LRS22HH, HTS221

Lys
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Where to get it mm

o Contact Mouse |# Feedback Change Location E usi
m ME?HBSECHE Products Manufacturers Technical Resources Services & Tools Halp Order History Login Register 'E @
Alv | EBY v son Cross
All Products > Embedded Solutions » Engineering Tools > Sensor Development Tools > OSee an Emor?

Muttiple Function Sensor Development Tools > STMicroelactronics STEVAL-BCNOOZV1B

Order in the next 58:18 [o ship teday. Leam More

STEVAL-BCN002V1iB In Stock: 49
‘,'_I Mouser #: 511-STEVAL-BCNOO2V1B Stock: 45 Can Ship Immediately
g
Mfr. #: STEVAL-BCNOOZVIB On Order: 30
View Dellvery Dates
M. STaicroelecironics
Factory Lead-Time: 11 Weeks
Customer #:
Minimum: 1 Multipies: 1
Enter Quantity:
Description: Multiple Function Sensor Development Buy
Tools BIueNRG-Tile - Blugtooth LE enabled
sensor node development kit Pricil‘lg (USD)
@ Enlarge Lifecycle: @Hew Product: New frorm this a Unit Bri Ext. Pri
" manufacturer. Y " R ALLHeR
Images are for raference only . 1 - 5
See Product Specifications Datasheet: 5 STEVAL-BCNDO2V1E Datasheet il $anad
'C Share More Information: Leam more about STMicroelectionics
STEVAL-BCNOD2V1B
NEWEST PRODUCTS
Shipping Alert: [EH] This product may require additional STMICROELECTRONICS

documeniation to export from the United
‘ , I States

life.augmented
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Online Support

https://my.st.com/ols

ConfactUs  English v
,’ Producls Search
= .augmented

Products [ Applications ¥ Tools & Software About ST & rt & Community

Welcome back! New user?
Enter your e-mail address and password to login your myST user. myST brings you a set of persanalized features
[
I L2 ]
E-mail address Participate to ST Event S‘— .
> Stay informed with ST eNewsletters uppo!

> Get help with ST Online Support

> Discuss on the ST Community

Password > Benefit from our Online Design Tools
> Download Software
> Qrder free samples

Remember me on this computer. > Manage your weekly product updates

> Buy ST Products & Tools

Create Account

life.augmented



Online Support =

"_’ STMicroelectronics Service Port}l  MewRequest J RAFRIVA (G
augrnanies

s

No Cases found. Click on ‘New Request’ to create one.

£37 stvicroslectronics Service Portal  NewRequest & RAFRIVA  C¢Logout

= ougrmartes

Case Details

Insert the Part Number

STEVAL-BCNO02V1iB

‘ ,I Type something

life.augmented



Introduction to
Bluetooth Low Energy




Bluetooth® Evolution

« 20 Years in the market!

>
- b (le 'é’
- 2009: Classic -> BLE > & & & A g
"b° ;\}OQ \}QQ < . . 00 Q,(\ ((\Q Q*
& L o & & L & )
& & X = & ° < PR
N & ¢ S O P
& & s & X £ & S 4V X &
R ) & @ & & Y &0 o & A VX
D R Q&c» @ 'aq? @ ‘\\v(/\ 4:(}\ z_‘_\é'“\‘\ PG Q:\s Qe,‘\'
R $ @ X ¥ ¥ ~ o g ¥ BNy
¥ O F & FS & (L& S N
& & FFS & & K E L &8 S
¢
¥ 6“’00 & oy v Qo"“ & & o VV'G
1.0 1.1 1.2 2.0 2.1 3.0 4.0 4.1 4.2 5.0
o @ @ O @ O @ @ @ >
1999 2000 2003 2004 2007 2009 2010 2013 2014 2016

Bluetooth 'CIassic

‘W . ) @ 5&(@\2 ,”,

lite.augmented




Bluetooth low energy (LE): Designed for Success __

- Lower power than Bluetooth “Classic” (or Bluetooth 3.0)
 Lower duty cycle
« Faster connection
« Lower peak power (relaxed RF parameters)

- Compatible with all major platforms (i0OS, Android, Windows, Linux)

- Multiple network topologies:

« Point to point: single master connects to single slave (and each slave can
connect to 2 master)

 Star: Multiple slaves connected to a single master
* Mesh: introduced in the 2017

- State of the Art encryption, security including privacy/authentication

Lys
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Protocol Stack

Application
B « Generic Acces Profile
* How a device can discover and connect with one another
- Generic Attribute Profile
o * How services, characteristics can be discovered and then used
— .
O -  Attribute Protocol
c L » Protocol for discovering, reading, and writing attributes on a peer
@ - Security Manager
-(7-) » Handles the secure communication
5| AR
) L  Protocol multiplexer. Segmentation and reassembly of packets
s s |
e % * Interface between Host and Controller
= Link layer » Link Layer . . .
— S » Handles packets, channels, advertising, scanning & connections
‘— * Physical Layer
, O L PHY layer * Transmits/receives bits

Q
C
Q
o
®
aQ

mery



Protocol Stack: PHY __

- ABLE Radio is a 2.4 GHz ISM Band Transceiver

* 40 RF Channels, 2 MHz Channel Spacing. Two types of channels:

» Advertising channels (3 - orange) for Advertising Packets. Used for Discoverability and
for Broadcasting/Observing

« Data Channels (37 - blue) for Data Packets. Used to send application data in Connection

- GFSK Modulation
« BT=05
* Modulation Index = 0.5

hernnvnerma 2R NCENO L3 NRIRERERRSNRR8ES » “pulse shaping” Gaussian
filter “smooths” transitions

-

Eg%%%g%%%’3ﬁii§§¥§¥¥¥ﬁ%%%%%%%%%;é%%%%%%% fromtzelro j[gtﬁne reduces
Tl gYIITEEEITINEEN3R398ITITIR000RGR0RERRRE T spectral wi
, w

life.augmented Source : Bluetooth® SIG




o}

.5]{ BLE System

Q

3
@

\

Host

=)
=%
®

a

Controller

Application

BLE Application Profiles

Host Controller Interface

Link layer

PHY layer

Protocol Stack - GAP

‘ - Who controls the radio network?
 GAP (Generic Access Profile)

e Defines 4 roles

- Broadcaster
» Observer

* Peripheral

» Central



I’'m looking
for John

g i Peripheral l I @

Peripheral is in Advertising mode.
Sends Advertising packets.

Central is Scanning.
Look for known peripherals by listening

to advertising packets.
My name is John

My capabilities are X, Y, Z,
etc...
1))
Advertising packets consists of multiple

')) information units known as AD types.
‘— E.g.: Local Name, TX Output Power,
> /4 Manufacturer Specific info, etc...

life.augmented

As the John peripheral is found,
it initiates a BLE connection.



\

Host

.5]{ BLE System

Q
3
(0]
=
a

Controller

|

Application

BLE Application Profiles

Host Controller Interface

Link layer

PHY layer

Protocol Stack - GATT

* Who controls the data flow?
 GATT (Generic Attribute Profile)

e Defines 2 roles

+ Server
e Client



GATT

Client talks to

i Server
Server contains ) Requests the server.
the data. BEVE! ‘ Sends requests
Receives requests, wait for rgs ons,e
executes, responds. Data Can confirrrr: '
Can indicate value Responses o
Data indications

Protocol PDU Type | Sent by | Description

Request Client Client requests something from server (it always causes a response)

Response Server  Server sends response to a request from a client

Command Client Client commands something to server (no response)

Notification Server  Server notifies client of new value (no confirmation)

Indication Server  Server indicates to client new value (it always causes a confirmation)

‘,I Confirmation Client Confirmation to an indication

life.augmented



Attributes

- Data are organized and exposed as attributes

Server
Each Data element Data
in the Serveris ~.__
- Each attribute has: called Attribute Data
- A handle: it identifies the attribute on the server Data
- Atype (defined by Universal Unique ID - UUID): what the
value means

» 16-bit UUID: pre-defined by Bluetooth SIG
» 128-bit UUID: Vendor Specific identifiers

- Avalue (0 to 512 octets)

(Handle [Type  [Value |
° Example 0x0009  «Device Name» “Temperature Sensor”

; ) 0002 Batey St 004
Y/ 0x0098  «Temperature» 0x0802
life.augmented

Source : Bluetooth® SIG



GATT Profile

Profile

Service _
A GATT Profile defines how attributes are

Characteristic : oL
_ organized and how the application can
Characteristic access them.

- Attributes are organized in Services and
Characteristics

Service

Characteristic
Characteristic

a typical example:
1 service: “ARG” (Angular Rate and Gravity)
2 characteristics: “Gyro”, “Acc”
Values: [0,-1,+2], [-10,+15,+950]

life.augmente:



ST BLE devices




ST BLE Roadmap

Dual Core BLE STM32WBxx

BLE 5.0 Application processor
Dual core Cortex-M4 / MO+

u
BlueNRG-Tile
RAM: 128K up to 256K
UQFN48, VQFN64, WLCSP100

BlueNRG-LP

BLES5.0 Application processor
Cortex-MO0+ 64MHz, 256KB
Flash, up to 36 GPIOs

BlueNRG-2 QFN, WLCSP
BLE5.0 Application processor in development
Cortex-M0 32MHz, 256KB
QFN32, QFN48, WLCSP34

BlueNRG-1
BLE4.2 Application processor

Cortex-MO 32MHz, 160KB \
QFN32, WLCSP34 ;

BlueNRG-MS
BLE4.1 Network processor BlueNRG STM%ZB‘-\\

QFN32, WLCSP34
PERFORMANCE

"
L
o
=
<
i
LL

Lys
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BlueNRG-2 SoC at a glance

Optimized BLE
Radio stack

The lowest power Processing power on Flexible memory
consumption demand architecture

Maximum security

o

>3 years lifetime on Low-power 256 KB eFLASH 70 kB FLASH ECC-256
CR20320 : ) 24 KB ULL SRAM 8 kB RAM AES-128
59 UAMHz amﬁ‘ﬂ'ge%“;‘;’ ,\CAOHr;eX (with full SRAM data 0.9uA with full RAM Factory UID
0.9 pAsleep retention) retention Secure KEY
Seamless connection Robust and

@ U

3

with SENSORS ~ Reliable BLE Link ~ Smal form factor

Bluetooth 5.0 Privacy 1.2 and secure  Faster and more
certified connection 4.2 reliable data transfer

&

Sensors

life. ted . . . . .
s (*) Based on the average current consumption in connection mode (7.059 pA, connection interval 1000 ms)



Bluetooth LE programmable processor

Bluetooth LE
5.0
ULP radio

ARM

Flash PROGRAMMABLE
Cortex MO with eFLASH

32 MHz o1 ~7:\\' [ |to host application code —
L 24 KB

e A

Advanced High-Performance Bus (AHB)

-

~
PDM Decimation 12C RTC
PROGRAMMABLE | RGeS filter (timers)
PERIPHERALS
ADC 10 bit DC/DC
El
J

PROGRAMMABLE
Digital I/0O

GIAR SIKEIL  Elatollic

m Tools by ARM

Lys
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STEVAL-BONO02V 1 g
; . Antenna
‘ A ‘%m

SWD Connector

32KHz XTAL to enable ultra- gz Balun
low-power BLE sleep mode / @ BALF-NRG
L2 bead to enable low- BLE SoC
BlueNRG-232

power BLE active mode

User button

NG

Pressure Sensor
LPS22HH

Microphone
MP34DT05-A

Accelerometer + Gyro
LSM6DSO

|2C for expansion

Bottom view

Magnetometer
LIS2MDL

m Time of FI|h

..... ©.augmented VL53L1 X

Humidity + Temperature
HTS221




Lys
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STEVAL-BCNOO2V1

Test points

RFTEST TEST ADC SDA SCL VDD GND antenna

Block Diagram

ot Viatching

—e RFTEST

Network’

LSM6DSO 12C
accelerometer + gyroscope IRQ
2C

BALF-NRG-02D3

Integrated balun

ADC

UART RX line User
Button

HEPLLDL | BlueNRG-2 RGB LED
magnetometer
Bluetooth 5.0 Network and

LPS22HH
barometer

2C
400
. HTS221 2C kHz 32 MHz
Relative Humidity & Temp connector
2C

" |
VL53LA1 I
time-of-flight proximity

Application processor MP34DTO05-A

microphone

1.6 MHz

KPR a4l The 32kHz crystal enables lowest power BLE sleep mode.
The inductor enables lowest power BLE active mode.



STEVAL-BCNO0O02V1D

20-pin JTAG connector STEVAL-BCN002V1 Socket Micro-USB connector (bottom)

STLinkV3 socket

S BLOOO0 0,

STM32L151 (bottom)

J

life.augmented



BlueTile SDK overview

https://www.st.com/content/st com/en/products/embedded-
software/evaluation-tool-software/stsw-bluetile-dk.html

1. PC Applications

¥ Aooticat |
a B ° 2. Documentation
. Docs
a . Firmware 3. Pre-built FW images
.. Lib . :
e P'C;'f"' ° 4. Low level drivers and BLE stack library
L FIver
. Project o 5. Virtual COM port drivers
a - ity 6. Reference examples in source code
7. Utility section: IAR BlueNRG-2 Flasher

Lys
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Documents
- Open the Docs folder

10 WILITIBIE L ONMECTION_uIoENnes
| Radio_Driver
. Application . SPI_protocol_specification

« Device Datasheet

| | Docs. o STMBZAPIs Events_html
I\ Firmware Bl STMEZ SPL protocol eample bl - BLE stack documentation
. Library L STM32Z_UART_protocol_example_html « Release notes
& PCDrver b USE"W'EEHML_FW_“PEFWE-Fmffd”"? + APIs and events
& Project ||5_T.|f-"‘*‘iﬁ“—["Flm-l » Programming manual
L Utility L | license.bt

» Device (and kits)
documentation

e DOUble CIiCK on indeX.htm| + PCB design guidelines
» Bring up guide
» QGetting started

Lys
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Hands on overview



Labs overview
» Lab 1: Getting started with STEVAL-BCN002V1 “Serial Terminal Test”
» Lab 2: Connecting to the ST BLE Sensor app
 Lab 3: LED characteristic
 Lab 4: Accelerometer embedded events detection
» Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion
 Lab 6: Cloud data logging on IBM Watson

» Lab 7: Voice over BLE



Lab 1
Getting Started with STEVAL-BCN002V1B

Ly “Serial Terminal Test”



“Serial Terminal Test”

* Plug the BlueTile to the PC using the USB cable

- Install and open Tera Term and configure serial terminal




Connect your STEVAL-BCNO0O2V1B
to the PC using USB

4.1 Favorites
BE Desktop
& Downloads
"5 Recent Places

4 |Libraries
Connect the USB cable oF 5 Documents
:~J5hmgt
The BlueTile comes already b [ Pictures
connected to the daughterboard B Videos

EIIE ﬁ Uhh (ST
RIL BIR ?‘(p

jJUuJUJJJJdeM /

"

a W Computer

b ﬁ 05Dk ()

U g BCNOOZVY (D)

=T

B

~—

./_' N
a / \
!.'—I. Agd
AZRONIB-TV¥ALLS
v p
2 W

ATNO.NOILYN 1A

4

GTAE

HWWEMUJUJUJJ

L ¢ o

‘_ o " On the PC file system a
/4

BCNOO02V1 drive will appear
life.augmented
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Windows7: Allow the driver installation

1. Click on Install driver software
anyway

® 2. Installation starts

mnﬁmﬂ enkaqu 's Website for updated driver software for your L - >

) 'wmmﬁ&a'ﬁmmmmmmam

"
;[ Seadetals




Virtual COM port driver

If you have issue with the STMicroelectronics Virtual COM

Port device driver installation here the iInstructions for
installing the Virtual COM port driver:

Win7 Win10




Tera Term Configuration 1/4

"

Host: |myhost.example.com

History .
ervice: . Telnet [CH porti: |22
2 SSH SSHwversion: |SSH2

Other g 5
Pratocol, |UNSPEC: -

G Port: | COM91: STMicroelectronics Virtual COb ~ |

‘ Cancel ‘ | Help |

1. Select the STMicroelectronics Virtual COM Port
« NOTE: on Win10 PC the serial port is labeled just as “COMxx”

Lys 2. click OK

lite.augmented



Tera Term Configuration 2/4
1. In Setup -> Serial port...

Set the following:
Baud rate : 115200 Port [t oK
. Baud rate: a 115200 v
Data : 8 bit e
Data: 8 bit Cancel

Stop : 1 bit | Stop: 1 bit Help
FIOW Contr0| * none Flow control: none

Transmit delay

0 msecichar 0 mseclline:

2. Click OK
&7

lite.augmented




Tera Term Configuration 3/4

1. In Setup -> Terminal... set
New-line Recelive :
AUTO

2. Click OK

'.- _- ;'"-:' _ur.:.a._.":'_- "-: i X
Terminal size a New-line ﬂ
85| % 34 Receive: [ALHQ_ = —

_ Cancel ‘

Transmit: | GR{LF ~

Wi Term size = win size

Ll Auto window resize

Terminal ID: |VT100  ~| ! Local echo

Help

Answerback: | Auto switch (VT<>TEK)
Coding (receive) Coding (transmit)
UTF8 -
locale: amerib__an CodePage: 55001



2. Click Save
@

Lys
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Tera Term Configuration 4/4
1. Click Setup->Save setup...

T Tera T
File  Edi

o

[ Tera Term: Save setup
———
L -;u | v Computer ¥ Windows (G:) » Progrem Files (:86) v tersterm b - | +4 || Seqrch terotem 2 |
Crgamize » New falder = I&
s " 2 Name Datz modified Type Size
o Favarites
B Desktop . cygterms+-iG86 5/4 /2018 857 PM Filefolder
¥ Downloads . cygterm+-x56_64 5/4/2018 6:57.PM File folder
%l Recent Places || lang S/4/2018 6:57 PM Filefaldar
& Windows (C) | plugin S/4AMEESTPM File falder
ca LocalDisk (D) 1 theme 544 /218 8:57 PM File foldes
& | TERATERM.INI 114772018 10:52 AM  Configuration sett KB
A Libraries
S Computer
BT v wes -
File narme:  TERATERM.INI -
Save a5 type: |setup files (ini) "|

= Hide Folders

Help

| @




on the daughterboard

| COMIEY - Tera Term VT

| File= Edit Sstip Control  Windo H=lp

# STEUAL-BCHBBZU1 #

Scan for sensors:
Accelerometer and Guroscope: 0K
Pressure and Temperature: 0K
Humidity and Temperature: 0K

Magnetometer: 0K
Proximity Sensor: OK
Sensor in low—power: OK
Battery voltage iz 32V0mU: OK
OTA update iz NOT supported
Device 'BCN-BB2' discoverable with

MAC:

Ef:z29:hS5:chH:ca:zc?

If you see the output above, Tera Term is now properly configured

Lys

ie.augmented



Lab 2
Connect to the ST BLE Sensor app

life.augmented



Customize YOUR STEVAL-BCNO0O0O2V1

DIKEIL o,
leSlon®5

ntegrated Development Environment

+ STEVAL-BCNO002V1 DK
Sensor Demo ref FW

L it  trademark and p\umm Ea mgmmdmm ark of AHM Led All rights reserved
This peoguct ctod by LS and intarnations! lyws

3 ERAERET T

\‘.—\; BCN-034
BlusNA

UENAG 1A:AT:E3:3F:ET:ES

ST BLE Sensor

omentad Client



BLE SensorDemo application

1. In the BlueTile SDK browse the following path: STEVAL-
BCN002V1 DK 1.1.0\Project\BLE _Examples

s [ o [ [

, BLE_Beacaon

. BLE_Chat

. BLE_HID_Peripheral

. BLE_OTA_ResetManager

BLE OTA Servi er The BLE_SensorDemo
. BLE SensorDemo | ‘ embedded application is the

T — — -

. BLE_Throughput
. BLE_Throughput_EXT
. DTM

main reference



Integrated Development Environment: _
Arm Keil MDK

* MDK: Microcontroller Development Kit

« Complete software development environment from Arm for a wide range of
Arm Cortex-M based microcontroller devices.

« MDK includes the pVision IDE, debugger, and Arm C/C++ compiler

- A FREE license is available for ST BlueNRG-2
« Go HERE to get the free license!

57
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BLE SensorDemo application g

=]
®

BAd@ 4 ath|s |- EEAR @ usr e ruor- B A @) 5 & @|[FF X
& 10| ] Retease <

= it Project: BLE SensarDemo
545 Release:
8 [ BlueNRGI_Periph_Driver
&3 Platforms Layers
1] SDK EVAL Comi.c
SDK_EVAL Canfig.e
1] SDK_EVAL Button.c
[ sox.EvALDCe
1] SDK EVAL Led.c
B FFF’S?IE.G;
) Us2mMDLe
1] LPSZZHH.
LSMEDSL.e
1] LSMBDsO.c
i[5 Startup
D User
(] BlueNRGL it.e
L‘; g@ﬁ_d_b.r-_
EI SEMSOTL
1 sensorDemo_main.c
@3 Hal
D Stack
11 libbluenrgl stacka
] stack user cfy.c
1 liberypto.s
& (4 OTA
@ 3 visx
= MotionEX
| 13 MationfX100 CMOP Keil ctib
= 5 BlueNRGL BlueVoice Library
1 bluevniceADPCM BNRGL 100 Keil lib

S7h

life.augmented i Project :Qﬁwki | £} Funetions | DaTemnlates |




Pjed s

IR — Application structure

& [ BlueNRG1 Periph_Dfiver
& L5 Platforms_Layers
|] SDK_EVAL Csmic
| ] sDk_EVAL Config.c
|] SDK_EVAL Buttoni
gzg:—:;i—f‘f = HW peripherals drivers and platform layer files
D E-FFS:'{Z[_.C_
1] Ls2MBL:
|1 LPS22HH.c
] LSMEDS0.c
# 3 Startup
& F User " -
T Application source code
L] BlueNRGL it.c - Main

] gott dbc " - ATTRIBUTE Database

I_il SENSONC

I_j ‘Sensorlemo_main.c - Application

I_EI HWaAdvanceFeatures.c —
el _}— Hardware Abstraction Layer and sleep management
T |1 libbluenrgl_stacka ] ] ] ]

ﬁ stack user cfgc BLE Stack library — provided in binary format

liberypto.a
= [ OTA -~
& O3 VIsILx
& [F MotionFx

1S72 2 Mot e et __p— Sensor Data Fusion library

J\

= L5 BlueNRG1_BlueVoice Library

life:augmentsd 5] hEuEmi.CEADFEM_ENRGI_IDQKEH.HE} Voice over BLE library



A look at the main application

int main(void) {

Systeminit(); | Remap the vector table and configure all the interrupts priority

I

SdkEvalldentification(); | Identifies STEVAL or custom PCB

\

Platforminit(); | HW peripherals initialization

|

BlueNRG_Stack_lInitialization(&BlueNRG_Stack_Init_params);| BLE stack initialization

Sensor_Devicelnit(); | Sensors initialization

|

Set_DeviceConnectable();| Set device in advertising

|

while(1){ | Start of while loop

BTLE_StackTick();] Advances the stack FSM
User_AppTick();] Advances the application FSM. THIS IS DEVELOPERS USER SPACE!

ﬁ } // end while(1)
}

J\
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Step 2: Scan

Master is in discovery mode
looking for a specific slave to connect to

step 3: COonnection request {

step 4: Services & Chars {

discovery
Master (Client) starts the BLE Service
and Characteristics discovery procedure
to understand the Server ATT DB

Lys
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m (@)

e

BLE flow on the LAB

i

Peripheral

Advertise

Advertise

Slave is in Peripheral mode and
sends ADV_IND PDU

Advertise

Connection request

Connection created

Service & Characteristics

discovery .
N ................. o _
step 5: Data flow
) I - Slave (Server) starts sending
J 100msecs periodically (100 ms) to the master,
N o notifications packets of sensors
’ Notification values (acc&gyro and pressure)




.¢ Advertising and scanning

g Central ((“3 )))

o w’i—% b

o o SN
4

Advertise

Step 2: Scan

Master is in discovery mode looking
for a specific slave to connect to

Advertise Step 1: AdvertiSing

Slave is in Peripheral mode and
sends ADV_IND PDU

Advertise

Connection request

step 3: Connection request {

Connection created

Master:
needs an app for
discovering the slave
device in advertising

‘,’ LightBlue® Explorer

life.augmented https://itunes.apple.com/us/app/lightblue-explorer/id557428110?mt=8

Off-the-shelf app: e.g. Custom app: e.g.

Z4




LightBlue scan results

®e000 Verizon LTE 10:31

Sort LightBlue | Explorer

@ 7 0 } 7% m.)

Filter

l,,“ BCN-034
51 No services

J

4 Unnamed
-16 No services

Gear 53 (385D) LE

-89 sarvices
. BCN-002
-8 No services

GoogleHome3429

-8 1service

BlueMS1

-1 No services

Unnamed
-95 No services

Unnamed
-89 No services

MetaWear

-86 1 senvice

Info | PunchThrough

Log

Lys
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Scan results

ST BLE Sensor scan results

eee00 Verizon LTE 10:30

< Back Devices

@ 7 @ ¢ 87% =

X

) BCN-034

1A:AT:E3:3F:E7:E5

_
) BCN-002

BLNAG D3:D0:38:ED:C2:E4
—

Why some devices are not present
in the ST BLE Sensor app?

How devices will pop up in
the ST BLE Sensor scan list?



ST BlueMS Protocol

* In order to be connected to the ST BLE Sensor app, a BLE peripheral
SHALL comply with a specific advertising packet format

- ST BlueMS protocol specifies a 26-byte packet format composed of
Advertisement Types — ADTypes - compliant with BT SIG definitions

Pre Acc Addr ,es. AdvA AD Flags BlueMS Adv Packet

Type Foocol Derice  Feate Device MAC Len Type LocalName Len Type Pwr
K 1 1 1 4 6 K 1 7 | 1 1
| |
Manufacturer Specific Complete Local Name  TX Out Power
ADType ADType ADType

Len =13 Len=8 Len=2
"I Type = OxFF Type = 0x09 Type = 0x0A



BlueST SDK for Android and i0OS

GitHuh This repository  Search Explore Features Enterprise Pricing

‘l‘:, STMicroelectronics-CentralLabs / BlueSTSDK_Android © Watch 3

A d - d
n r O I Bluetooth low energy Sensors Technology Software Development Kit (Android version)

https://github.com/stmicroelectronics-centrallabs/bluestsdk android B 5 branihos E— —

Ll Banch master-  BlueSTSDK_Android / + =
% GiovanniVisentini Update README Latest commit 573ce4 10 days ago
@8 BlueSTExample Initial commit 14 days ago
B BlueSTSDK Initral commit 14 days ago

E) gitignore Initial commit

B} LICENSE Initial commit
u B README.md Update README 10 days ago
Source code foriOS and ==
B settings gradie Initial commit 4 days ago

u
A n d ro I d GitHub This repository.  Search Explore Features Enterprise Pricing

: STMicroelectronics-CentralLabs / BlueSTSDK_iOS ©Watch 3

available online and maintained on GitHub repos

Bluetooth low energy Sensors Technology Software Development Kit (i0Sversion)

|
I {® 2 commits i 2 branches <> 0 releases & 1 contnbutor

https://github.com/stmicroelectronics-centrallabs/bluestsdk ios B sonch master- | BlueSTSDK_iOS / + =

.i. GiovanniVisentini fix parse error with multiple feature in the same charactenistics  «= Latest commit c@e8d1 2 days ago
Il BlueSTSDK fix parse error with multiple feature in the same characteristics 2 days ago
‘ , I i BlueSTSDKExample fix parse error with mulliple feature in the same characteristics 2 days ago
E) LICENSE Initial commit 9 days ago

life.augmented

&) Readme md Initial commit S days ago



ST BLE Sensor Scan results

Type ©rotocol Dﬁ‘gce anaat:lze Device MAC Len Type Local Name
sesco Verizon LTE 10:30 @ 7 0§ 87% wm>
< Back Pevices ~ Each ST Platform is recognized by means of a
B P esreres Device ID
BCN-002 (for STEVAL-BCNOO2V1 it is equal to 0x05)

Users can distinguish their node from \\\:
BlueNRG

the Local Name




Customize your BlueTile

Project
= 1§ Praject BLE SensorDemo
= %5 Release
4 BlueMRGL_Periph_Driver
& O Platforms_Layers
w2 Startup
=& User
L] BlueNRGL it.c
|1 gatt db.c

1 =ensorc

|j SensorDemo_main.c
] HWAdvanceFeatures.c
|_"| hw_config.c

w8 Hal

@ O Stack

w2 OTA

@ [ VIs3LX

W 4 MotionFX

ﬁ @ [ BlushRGl_BlusVoice Library

life.augmented



Customize your BlueTile

Modify the local hame in the advertisement payload

1. In the file Sensor.c go to line 52

2. “BCN-002” is the default local name value
3. You can modify it as you prefer with a 7-characters string

#define DEFAULT NAME ALLMEMS




Build the new code

1. Click on the Build button (top left corner)
or hit F7 on your keyboard

2. In the Build Output window (bottom) wait for -, Y g
the build to be completed. Hoe | L) buma D
- BLE_SensorDemo.bin created C “‘iﬁ Rz:‘a’:ﬂm“”“’-”“
« “0 Error(s), 0 Warning(s)” message appear |

; Release

Build Cutput
e 15311_wait. Cuuw

compiling v15311 register funcs.c...

compiling v15311 platform.c...

linking...

Program Size: Code=121908 RO-data=1428 RW-data=1136 ZI-data=21252

FromELF: creating hex file...
Lfter Build - User command #1: fromelf.exe —-bin ..%..%..\..\..\..\HandzsSes - ELE SensorDemo.axf —-output ..%\..%..\..%\.J..\HandsOn\BLE_ SensorDemo PrjCutput\BLE SensorDemc.bin

"o \HandsOn\ELE_SensorDemo_ PrjCutputM\BLE SensorDemo.axf" - 0 Error (s), O W;mingts} .
Build Time Elapsed: 00:00:12

Lys
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Programming embedded Flash

1. UART Bootloader

« ROM bootloader. HW activation through dedicate pin (DIO7) configured for Boot
» PC interface named “BlueNRG-1_2 Flasher Utility” available in the SW package

2. SWD interface + ST-LINK
* Interface with the STEVAL-BCNO002V1 through the 20-pin JTAG connector
« Same PC interface BlueNRG-1_2 Flasher

P

ST-Link’ . z RO |
& \ ' 1 EL o ’r
= P > ‘ " \ a iR 7
A S e

"I Nucleo

life.augmented

Remove CN2 Jumpers
and plug daughterboard
on top




Flash memory layout 1/2

SDK Projects

0x1007E800
OTA h|g her app BLE_SensorDemo_HigherApp_OTA
(1 24kB) BLE Chat_Server_HigherApp_OTA

0x1005F800
OTA lower app BLE_SensorDemo_LowerApp_OTA
(1 24kB) BLE Chat_Server_LowerApp_OTA

0x10040800

Reset manager (2kB) BLE_OTA_ResetManager
0x10040000

BlueNRG-2 Flash
KYI

life.augmented



Lys
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Flash memory layout 2/2

SDK Projects

0x1007F000
Ap p| ication BLE SensorDemo_Use OTA_ServiceManager
with no OTA service BLE Chat_Server_Use_OTA_ServiceManager
( 182k B) BLE Beacon Use OTA_ServiceManager
0x10051800
OTA Service
Manager BLE_OTA_ServiceManager
(70kB)
0x10040000

BlueNRG-2 Flash



UART Bootloader: use BlueNRG-2
Flasher Utility

* On st.com at this link:

https://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrgflasher.html

STSW-BNRGFLASHER | = g= pPrint M SavetoMyST Share via Email

BlueNRG-1, BlueNRG-2 Flasher ufility

Get Software Download databrief

Overview Resources

The STSW-BNRGFLASHER is a standalone PC application which allows the BlueNRG-1, BlueNRG-2
devices Flash to be read, mass erased, written and programmed.

Lys
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Open the Flasher Utility gm

1. Go to
C:\Program Files (x86)\STMicroelectronics\BlueNRG-1_2 Flasher Utility 3.0.0\Application
1. Double click on BlueNRG-1 Flasher GUl.exe ==
| o% ‘

Size 0x3000 . Read | e |
3 4 5 6




For HD screens...If you've problem with the resolution

- Right Click on the .exe file and select Properties

- In the Compatibility tab select either Disable display scaling...
or Override high DPI scaling... — Application

Lys
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R s
|7 BlueNRG-E =
|| BlueNRG-1 P
Bl #  Runas administratar
I_I: Micrasaft i Troubleshoot compatibility
% mevemgodll 2P }
{%] msvcpgnian|  CRCSHA X
% mayed0,di | = Editwith Notepad-+
|| PyQtd.GtCo Scan for Viruses..,
|| PyQe.CA6ul & winherge
[P
[%) pythonZZ.di Unpin from Taskbat
&i pywintypes2 Pinto Start Menu
L& GtCored.dll Restare previous versions
o QtGuid.dil —
|4 QtOpenGly|  Sendto X
% QtSvad ol cut
] Qrmid.dll Copy
|| select.pyd
B Create shortcut
O uieosemsg|  REEE
Rename
3350 PM ——
Properties

&7 BlueMRG-1_2 Flasher GUl.exe Properties

¥ this program lsn' working comectl on this version of Windows,

try funining the compatibilty troubleshoster.
[ Fon conpaity oot |

How dip | choase compatibility ssitings maruaiv?

Compatibilty mode
[l Run this program in compatibiity mode for:

Widgwa 2

Settings
] Reduced color mede

bE 255 coir

I [ Chsabis display scaling on high DP| ssttings

|1 Run this program as an administrator

Q_E}a@m forall usem . |

0K || Concd |

X

]
&7 BlueNRG-1_2_Flasher_GUl.exe Properties b 4

Geneml || Compatibdty § Securty  Detads  Previous Verions

i this program tsn't working comectly on this version of Windows,
try running the compatibiity troubleshocter

[ conpaity vaesoctr |
How do | choose compatibilty settings rmatialyT
Compatibiity mode

] Run this program in compatibility mods for.
Windows 3
Reshuces] coloe mids

e
ide high DFI scaing behavior

%]

Applcation v

[ B thes program as an administrator

Ok || Concal | Mok |




BlueNRG Flasher Utility

Fil= ool Help

2 e e
SelectImage file | No/Image filefo . | Select Image file | No Image file Inadsd.
Flash from Address: |0 10040000 |1 Fmsh ] swp | = = -
uaRT [swp UAR I Flash from Address: |[x 10050000 | | Fizsh | | Siog
Actions. List of COM Ports: U
ART f
I Automatic Mode rky ST 0} — Lo |
7] verify Actions List of COM Ports:
171 Mass erase ( - : ) ||_" co (ST DK]
[¥] Update Divice Memory |J Automatic Mode {only ST OK) ._I M29
e
V] verify [T cones
Device N
ki Progtatiiog [ Mass srase
|
|7 B [¥] Update Device Memory
Device Memory | Image Fie \ J
Start Address 0x10040000 Size (x3000 Read | wmi |
0 1 2 3 s 5 6
SelectImage fle | No Image fie loaded,
il i1 i ' £ 1
Flash from Address: | (010040000 |l Fasl 1] kg |
Log P —
usgr]| swo |
\—— =
AActions: [T Mac Addeess
] Automatic Mad= MAC Address: Starf: GrBOROBONONID - End: CrOENOTONONT
9] verify
MAC Flash Location Ox 10067553
|| rReaduout Protection | |
Loadlog,. | v toghia I dGleitony I I e— || Save MAC Address Loe.  File Name |
N.Board: 0/ || | 0% [7] Update Deyice Memary { Seit Mse Address,. |
\ J




Flash the BlueNRG-2 1/6 g,

1. Select the COM port labeled (ST DK)

UART | swp |
Achons List of COM Ports:
A
| Automatic Made (only ST DK) [¥] COMSL (ST DK} J
9] verify




Flash the BlueNRG-2 2/6

1. Device Memory will populate with data

Device BlueNRG-2 {mayx fiash address: 0x1007FF)

Reading Memory COMS1
100%

|DE\ﬁm{¥IEanyCm91| Image File |

Start Address 0x 10040000 Size 03000 [ Read || Wi

B T =23 4 5 B |7 B 8 W 3.32 3F 34 | 15 ASCH e

(el 0040000 00 60 00 20 D9 07 04 10 35 06 04 10 3D D& 04 (10 s = IJ

10040010 Af 55 '35 AA 00 00 OO0 0D 00 OO 0D 00 00O 00 00 0D SUUR

(hl0040020 00 00 0O OO 0O 00 00 00 0D 0O 00 OO0 45 06 04 10 -

0x10040030 00 00 00 0O 00 00 00 00 4F 06 04 10 59 06 04 10 oy

Log

1£:10:30.632: Dewice COMS1 —> Head Bosrd Sterted

16:40-31_701: Deviee OC0MS1 —> Hisd Hosrd Znd

Lys
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Flash the BlueNRG-2 3/6

1. Select Mlass Erase

UART | swp | W
-Actons List of COM Ports: Actions List of COM Ports;
7] Automatic Mode (anly STOK) | (4] COMBL. (ST BK) | 7] Automatic Mode (enly STDK) |14 COMBL (ST DK)
@ ) -
[] Mass erace [¥] Mass erase
[¥] lipdate Device Memary [¥] Update Device Memary

Lys
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Flash the BlueNRG-2 4/6

1. Click on the Select Image file button

kw7 BlueNRG-1_2 Flasher - Utility v2.0.0

T i
ol o Tl

[| Selact Image file Uﬁn Image file oaded,

And browse the following path

STEVAL-BCNOD2VI DK1.1.0 » Project » BLE Examples » BLE SepsorDemo » MDE-ARM » BlueNRG-2 » LowerApp OTA » Dbjects }

2.

i s}



Flash the BlueNRG-2 5/6

1. Select the binary file (e.g. BLE_SensorDemo_LowerApp_ OTA.bin)
and click Open

2. Insert the correct start address (e.g. 0x10040800 for Lower App)
3. Click on the Flash button

&7 BlueNRG-1.2 Flasher - Utility v3.0.0 =B &

| Selact Imaae fie | C:/Usersjraffacle riva/Desktop/TestBlucTie_DK 1. 1/20 190325 STEVAL-BCNOD2V1 DK 1, 1,0/5FErA-Behaasy-+Be
1,1, 0/Proj xampies/BLE - Sensorfemo/MEK-ARM/BluelRG-2 LowerApn OT AfD‘i'_‘lj-'E# ts/BLE_SensarDemo_Lowerdpo OTA.bin

10040800 St

ﬁﬁﬁﬁﬁ 1iet mf PR Dt



Flash the BlueNRG-2 6/6

1. Flashing starts: green bar proceeding

P

2. Wait for the pop-up window and click on OK

Device BluehRG-2 (may fath address: 0x 1007FFF)
Reading Memory COM91

57 BlueNRG-1 2 Flasher - Utifity

Dievice Memory COM21 |71mageﬂe |

~ || & DeviceCOMIL =5 Flashed and Vesified,
Start Address 0x 10040000 é Read | Wi

5 A:ooF 3 Ascn -
0x10040000 00 60 00 20 O | E
0x10040010° AA 55 55 AA 45 55 4C 42 00 OO 00 00 00 00 00 GULSEULE
00040020 00 G0 00 00 00 G0 00 G0 00 G0 00 00 2 12 04 1D !
(:10040030 D00 00 00 00 00 00 00 00 D7 06 04 10 23 12 04 10 . = _

Lo

2

ww&START FLASH ODERRTITN%*+
Flash Beoards:; COM31 (ST DE)
16:17:31.612: Device COMS1 -> Flash Frogramming

‘ A&-IT:32.171; Device C{fm!il —= Hesd Soard Sterved
1£:17:32_EB84: Deviee COMS! —> Rssd Board Znd

1E:1T:32_917: Dewice COMSL <> Flazhed ‘and Verified.

life.augmented



SWD: use BlueNRG ST-LINK utility

* On st.com at this link:

https://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg1stlink.html

STSW-BNRGI1STLINK | s = Print M save o MysST Share via Email

BlueNRG-1 ST-LINK utility for BlueNRG-1, BlueNRG-2 MCU

Get Software Download databrief

Overview Resources

The BlueNRG-1 ST-LINK utility is a full-featured software interface for programming BlueNRG-1 and
BlueNRG-2 devices.

Lys
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Programming embedded Flash ___

1. SWD interface + ST-LINK

B, Blu=NRG-1 ST-LINK Utility
File Edit View Target ST-LINK Help

Hd @202 8

Memory lﬁs‘:ﬂl_a\d I Device BluehRG-2

Address:  0x10040800 = Size: (% 16FAS Diata Width: 32hits = Revison D Rev 0
Flash size 256KBytes
| Device Memary @ 0x10040800: [BnaryFile| [T]uvelipdate
[Target memary, Address range: [0x 10040800 Ox100577A8]

Address ] | 4 | 8 c ASCH =
OI0DA0EO0 (20006000 1004764D 10047931 10047933 " Mv, ly..3y. =
010040810 AASSSSAA  A24C5545 00000000 00000000  *UUZEULB........

010040820 00000000 00000000 00000000 10047935 RN
010040830 00000000 00000000 1004TSAF 10047939
| 0x10040840 1004795 100474B1 00000000 00000I0O
010040850 1004795  100474B3  100479C0  100474BF

010040860 00000000 00000000 000GDODD  ODDODOOD.  |....iisiiiins
0x10040870 00000000 100474C1 10047403 10M474Cs ... At At At

B B S ot T | I Y

<] i | L2

03:43:03 : STAINK SN : ST U065088435348330487
03:43;:03 + STHINK Firmwiare version ; V213157
03:43:03 : Conrected via SWD.

03:43:03 ; SWD Frequency = 4,0 MHz,

03:43:03 : Connection mode : Narmal,

Device s NuﬂG—Z
: Device family ;BlueMNRG-2
03:43:03: Device flash Size : 256KBytes

she o [ipedipdan Msstizo

Pebugin Low Power mode enabled, Pevice : BuelRG-2 Cores
R

==
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Open the ST BLE Sensor App

Download on the wll Verizon (TE 17:43 ¥ ©@ % 99% [ 4
S App Store
GETIT ON
P> Google Play

Launch the ST BLE Sensor
app previously installed

Connect to a device

Note: in the following slides all the pictures are -
‘—— referred to the iOS version of the ST BLE Sensor app. Version:4.22
The Android version is slightly different A g resemed

life.augmented



Connect using the ST BLE Sensor App
@ 2 L3

Tap Select your You are
“Connect to a device” BlueTile connected
all Verizon LTE 17:43 4 @ % 99% =4 ‘(’ Bac: on De\:ices . :ﬂ::ir:: LTE 10:42 @r1e% 859:;
BCN-034
1A:AT:E3:3F:E7:E5 ’ =
© . «> | Blow air on
, ~ ~ ¥ the
- Look for YOUR oo | o | Temperature
) 32,50 °C
3 Gt Local name — sensor 1o
k Connect t adeViCEJ befor.e ( \ Change the
- connecting! l temperature
@ N || and humidity
About ¥1013A73 mBar 51.50 % J Val u es
© Copyright 2018 s;;g%%g;:;; qﬁ‘ﬂl i .‘ 9 ﬁ ,




* “Device connected” will appear as connection is created
« Each time user moves on different tabs/screens in the app:

 BLE notifications on different BLE characteristics are enabled.
- Environmental and Gas Gauge/Battery characteristics are involved

T COMEL - Tem Term VT

!Erle Edit Setup Control Window Help

i STEUAL-BCHBBZUL #itd

can for senzops:
Accelerometer and Guroscope: QK
Pressure and Temperature: 0K
Humidity and Temperature: QK
Hagnetometer: 0K
Proximity Sensor: OH
ensor in low—pouwer mode: O
Battery voltage iz 3.31wv: 0K
Nevice iz _now _discoverable with MAC: f?:cl1:18:0%7:28:0h

fDevice connected
Calibration status reguested

nuvironnental Motification DN
nmuironmental Motification OFF
ﬁ Gas Gauge Motification ON
YI Gasz Gauge Motification OFF
nvironnental Motification OM

f ted
RS Environmental Motification OFF




ST BlueMS Protocol mm

In file sensor.c

Len Type Frowcol Dﬁ‘gce Fﬁn‘::;e Device MAC Len Type LocalName Len Type Pwr

389 i n o 2El s L 2 [ Jonorma/oons Doon Je O donom ) [l Teocomission Power 3 bytes TX output power
3590 . = T S

301 r 13, /* Length*/O0xFF, 0x01, /* SKD version * ytes Local Name
392 0x05,/% 0x05 BlueNRG-Tile Board */

3493 H#if ENABLE BLUEVOICE

394 Ox6a, /* ADPCM Sync + ADPCM Audio + Led + Brox */

385 #else

396 0x22, /* Led + Bxox */

397 - #endif

398 OxFE, /* agg + Gyro + Mag + Press + Hum + Temp + Bagg* ifi

390 Basr bnese maroae 13 bytes Manufacturer Specific

400 0x05, /% AccEvents + iNemo Compact */

401 Ox40, /* eCompass */

402 $else

403 0x04, [/* AccEvents */

404 0x00,

405 -#endif

408 0x00, /* BLE MAC start */

407 0x00, 0x00, 0x00, 0x00, 0x00, /* BLE MAC stop */

408 - ¥

171
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BlueMS Protocol — complete Feature Mask

4 Bytes

Type Frotocol Device  Feature Device MAC Len Type LocalName Len Type Pwr

version ID Mask

Ox6A

Proximity

OxFE
Battery 2nd Temp

q 4 2 | 1| 0 [
SensFus | Compass | MotionInt

Activity  Carry Pos MemsGes ProxGes Pedo

uugmemed




How Feature Mask is mapped onto ATT DB?

- 3 services: HWServW2ST, Config, HWServWasT
and COﬂSOle Environmental

- Each bit of the 4-byte Feature fee o T LED
Mask in the Advertising packet Acc Event Quaternions

corresponds to a HW/SW feature Battery

 In the Server ATT DB a BLE ADFCH ADPCM Synch
Characteristic has to be added

Console

for each bit of the Advertising Term Char
Feature Mask

STDERR Char

&y

life.au



BLE SensorDemo ATT DB

Froject
=% Praject: BLE SensorDemno
£ 3%d Release
L BlueMRGL_Periph_Driver
il [ Platforms_Layers
L Startup
E-@ User

] BlueNRGL it The ATT DB is defined and

] gatt db.c
T semsare created in the file gatt_db.c
Ij SensorDemo_main.c -

L] HWAdvanceFeatures.c

12 hw_config.c

w2 Hal

& [ Stack

w i OTA

@ O VLS3LIX

r i MobonFx
,I & O BlusMRGL_BlueVoice Library

life.augmented




BLE SensorDemo ATT DB
HWServW2sT

12 N.R 128-bit  001D0000000111e1ac360002a5d5¢51b
20 N 128-bjt  00E00000000111e1ac360002a5d5¢51b
5 N.R 128-pjit  00000400000111e1ac360002a5d5c51b
9 N.R 128-bit  00020000000111e1ac360002a5d5¢51b
“ 4 N.R 128-pjit  02000000000111e1ac360002a5d5c51b

LED 3 N.R 128-bit  20000000000111e1ac360002a5d5¢51b
8 N 128-bit  00000100000111e1ac360002a5d5¢51b
m 4 N 128-bit  00000040000111e1ac360002a5d5c51b
20 N 128-bit  08000000000111e1ac360002a5d5¢51b
6 N 128-pjit  40000000000111e1ac360002a5d5¢51b

NOTE: two additional bytes for a timestamp for each char




Example: Battery Characteristic
ENENENENERENERER -

ADPCM Switch ADPC MicLevel  Proximity

Gyro Pressure  Humidity = Temperat

-mnnmn 0x00
Beamform AccEvent  FreeFall
-nnnnn B oxo0

SensFus Compass  Motionint Activity  Carry Pos MemsGg ProxGes Pedo

UUID VALUE

HWServW2ST 00020000000111e1ac360002a5d5¢51b

The UUID values are linked to

the Feature Mask in advertising




BLE SensorDemo ATT DB 4

Each characteristic is defined by the following key parameters

Console PROPERTIES | UUID TYPE UUID VALUE

Term 20 N.R 128-bit  00000001000E11e1ac360002a5d5c51b

STDERR 20 N,R 128-bit  00000002000E11e1ac360002a5d5¢c51b

/

This byte differentiates the Service

20 N, Ww/oR, 128-bit 00000002000F11e1ac360002a5d5¢51b
R,W

life.augmente:



BLE SensorDemo ATT DB

tBRleStatus Add_HWServW2ST Service (void)

aci_gatt_add_service (UUID_TYPE, UUID, ..,MAX NB_ATTRIBUTES, &ServHandle)

aci_gatt_add_char (ServHandle, UUID_TYPE, UUID, Length, PROPERTIES, PERMISSIONS, .., §&CharHandle)

HWServW2sT HWServW2STHandle = 0x000C

— EnvironmentalCharHandle = 0x000D
AccGyroMagCharHandle = 0x0010

Config —— Confi1igW2STHandle = 0x002B
Config Char ——— ConfigCharHandle = 0x002C




BLE SensorDemo ATT DB

Char Declaration EnvironmentalCharHandle = 0x000D

s

s

Environmental
~

- Declaration Handle: used by the application to access the Characteristic

Char Value Handle = 0x000E

Char CCCD Handle = 0x000F

- Characteristic Value Handle: used by the Client for Read/Write operations

* Client Characteristic Configurator Descriptor (CCCD): a GATT
descriptor is added by default by the stack, if char has Notify/Indicate
property. Used by Client to enable notifications/indications on char value.

Lys
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Central: Services and Characteristics

. | 89
UUIDs  Handles AISCOVErYy procedure

‘Name Handle Property Value Values Value Length ‘
4 @ Service User Defined {0x000000
a [l Charscteristic User Defined (0:001 DO000000111 ELAC3E0002A5D5C 51 B 03000D) Read, Motify lUﬂHFﬂmnBCUﬂUlBBQCMﬂElUﬂC
& Client Characteristic Canfiguration £) G2
¢ @ Characteristic User Defined ((00ED0000000111 E1ACIE0002ASD5CHLE) 00010 Matify
n Client Charactenstic Configuration (0x2902) 00012 0000 o2
] ] a [l Charactetistic User Defined (0:00000400000111 ELACIS0002A5D5C518) 040013 Read, Motify 00000002405 Dx05
T h IS IS h ow B Ciicnt Characteristic Canfiguration (0:2902) 0x0015 00000 002
4 . Characteristic User Defined {(x02000000000111 ELACI60002A5D5C518) 0x0016 Read, Maotify (uB8A1232E Qa4
n Client Charactenstic Configuration (0:2902) D018 0000 02
ATT D B a [l Characteristic User Defined (0x20000000000111 FLACIS0002A5D5C518) 030013 Read, Motify Dx0024E5 0x03
B Client Characteristic Canfiguration (0:2302) 0x001E w0000 w2
IOO ks I i ke 4 [ Characteristic User Defined (0000200000001 F1 AC360002ASD5C518) (01 Read, Notify 0M0180000C BADIERABS3 0409
n Client Charactenstic Configuration (0:2902) D001E 0000 Ouli2
a [l Characteristic User Defined (0x00000100000111 FLACIS0002A5D5C51R) Ox001F Motify
fro m t h e B Client Characteristic Canfiguration (0:2302) 00021 00000 002
« @ Characteristic User Defined (0000004000011 E1 ACIE0002ASD5CE1E) 040022 Natify
n Client Charactenstic Configuration (0x2902) D24 0000 o2
Ce N t ra I a [l Cherscteristic User Defined (0x08000000000111 ELACIS0002A5D5C51B) 050025 Notify
& Client Characteristic Canfiguration (0:2302) 00027 w0000 02
« [ Characteristic User Defined (0x40000000000111 EL ACIA0002ASD5CS1R) 0x0028 Natify
n Client Charactenstic Configuration (0x2902) 00024 0000 o2
4 [ Service User Defined (0400000000000FL1E19.4B40002A505C518) 0x002B:
4 [ Charscteristic User Defined (0000000200011 ELAC360002ASD5C518) 0w002C Write w/o resp, Nofify
n Client Characteristic Configuration {Qﬂﬂ!] D:002E OO0 2
4 - Service User Defined ({0x00000000000E11E19AB40002A505C518) D:002F
a [l Charactetistic User Defined (0:00000001000EL] ELACIS0002A5D5CS1R] 040030 Read, Write w/o resp, Write, Notify Ot} 00
‘ B Client Characteristic Canfiguration (0:2302) 0:0032 w0000 w2
’I 4 @ Characteristic User Defined (0x00000002000E1 LEL ACIRO002ASD5C51B) (w0033 Read, Natify 0 000

----- augmented W8l Client Characteristic Canfiguration ([x2902) 00035 0000 G2



BLE Sensor — Characteristic update g

Central (((GB ))) Peripheral

Connection created

Notification

aci_gatt_update_char_ value (ServiceHandle, 0x000C, //HWserv handle
Description Where CharHandle, O0x000D, //EnvChar handle

If notifications (or indications) are enabled Offset 4 0x00 ’
on the characteristic, this API sends a GATTserver | T,e ngth, 0x08
notification (or indication) to the client. !

Lys
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Cortex-M0 Sleep management um
Central (((63 ))) Peripheral

Connection created w 8 - Sleep mode managed through specific a library and API
* BlueNRG_Sleep(sleepMode, gpioWakeBitMask, gpioWakeLevelMask)

Notification

- 4 wake-up sources: timers, DIO11, DIO12 and DIO13
« Timers: 4 virtual timers mapped on 2 physical timers managed by the radio IP
« DIO11: Interrupt line from UART RX or SW1 button
« DIO12: Interrupt line from Magnetometer

I1 00 ms

Radio Active
phase

Deep sleep mode
(i\ P sieep B
] Ji \ b

‘— Connection Intervals time
> /4

life.augmented

« DIO13: Interrupt line from 6-axis Accelerometer & Gyroscope




Typical scenarios

Active mode
Tx/Rx
Low throughput I Deep sleep mode
| I = ‘
- : time
Long Connection Intervals (in the orders of secs)

High thkoughput I I I I _I_I_I_I ..........

Short Connection time

Intervals (min 7.5msecs)

Active phase

typical plot X

A

RX

Start-up

| CPU |
Active CPU

XTAL  RX-2-TX Active

startup &
LL lock

CPU OFF

y

time

Lys
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Low Power Modes

- Deep sleep mode can represent most of the application time.

- Efficient management of sleep mode significantly lowers the avg power
consumption.

BlueNRG-2 flexible low power architecture

High
RUNNING 1.9mA Core running ighest pwr

Low Power library combines
requests coming from the

WAKETIMER 900nA  GPIOs and Timer Wakeup app'igggf;igg%tggeradio

CPU HALT 1.5mA WEFI instruction

NOTIMER 500nA GPIOs only Wakeup

Lys
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Lowest pwr



Context Save/Restore

* BlueNRG-2 Low Power Library handles autonomously entering
and exiting to/from the sleep mode.

- The library saves peripherals configurations and application
context before entering deep sleep, and restores the context on
exiting from low power state:

« CPU returns to execute the next instruction after the low power function call
* No need to re-initialize peripheral and radio stack
 RAM retention is guaranteed

NO need for the application to worry about

sleep management and RAM retention!
Lys
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BlueNRG Current Consumption
Estimation Tool

* On st.com at this link:

http://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg001.html

STSW-BNRGO0O1 | = s = print M Saveto MyST Share via Emall

BlueNRG cument consumption estimation tool

Get Software Download databrief

Overview Resources

The BlueNRG current consumption estimation tool can predict the current consumption under different
conditions, as defined by the Bluetooth low energy specification, for the BlueNRG and BlueNRG-MS
Bluetooth® low energy wireless network processors as well as the BlueNRG-1 and BlueNRG-2 Bluetooth®

rl low energy systems-on-chip.

life.augmented




BlueNRG Current Consumption Estimation ToO!l g

« Accurate estimate of average current consumption and battery lifetime

&7 BlusNRG Current Consumption Estimation Tool v.1.4 = |2
1. Select the device [ e piot setings Window Help

Caloulate Consumption Performance Summary
2. Select the type of Buecls; ]"‘d“‘ﬁﬁﬁf 4| ﬁ Time of active phase: 287 ms
General {Qadvertsng | Seaming, | Compection |
event \4 —_— e Average current during the active phase: 1.9°'mA
Type of Device: &l [#]
Total average current: 7.93 uA
High Power mode 1 Pout 14{-2dEm} vi o
i B B = Payload data rate: NA
3. Configure the HW Supply veffage (V) 5.0 =] Crystal Startup Time (os) 512 =
operating conditions // Retention RAM 2418 ~| Master 5CA {opm) [sEis) =] by Mt —
/ - = Battery capacity ( 230 =
4. Configure the Iriternial Low Speed Clock [[] Slavesca (ppm) 100 =
: : lifetime: ) th{s), 23 davy(
application use case el il Aadeiss el il
scenario / M
5. Specify the Battery capacity 6. Read the average current and the

estimated battery lifetime

Lys
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Lab 3
LED characteristic



Enable LED toggling wsm

00000 Verizon LTE 10:39 @ 7 O 3 86% M)
£ Devices ['T_'[
1. Tap the image on the
Click the image to change the status SC ree n
2. Send BLE notification
packet

3. Image changes color
and the RED LED
toggles

‘1’ LED ON
‘0’ LED OFF

Notification

Packet
—

4" LED ON
& & o - | ‘OLEDOFF




Code flow g

. Client enables LED characteristic notifications

. Client Writes in Config Char

Parse write command from the client and send BLE notification
on LED status from the server



ST BlueMS Protocol

Type F:,frt;gﬁ' Del‘l')'ce F:nzt:;e Device MAC Len Type LocalName Len Type Pwr

BlueMS 4 Bytes

ENENERENEAEREREE

ADPCM Switch DoA ADPC MicLevel  Proximity

NN (2 [ F 1 & ox1E

Gyro Mag Pressure  Humidity = Temperat Battery 2nd Temp

mnnmnmnn 0x00

Beamform AccEvent FreeFall SensFusC

7 | 6 | 5 | 4 | 3 | 2 | 1 0 [N

SensFus Compass Motionint Activity  Carry Pos MemsGes ProxGes Pedo

Lys
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‘ ) /4 o

Client enables LED characteristic
notifications

101

1. Inthe file gatt db.c go to the line 670

2. Client writes in the LED Characteristics Client Configurator Descriptor
(CCCD) and Server enables notifications through the

xFeatureNotification structure in line 673 by
xFeatureNotification.LedNotification = true;

670 l } else |if (attr handle = (LedCharHandle + Ei} i

671

672 H if (att_data[®] == C°1) {

673 XFeatureNotification.LedNotification = true;
674 T PRINIT("I=d OMnnITT

675 } else if (att data[C] = C) {

676 XFeatureNotification.LedWNotification = false;
677 PRINTF("Led OFF.\n\r™):

575 = }




Client Writes in Config Char mm

1. Inthe file gatt db.c go to the line 806

2. Client writes in the Config Char and Server parses the command through the
function ConfigCommandParsing(att_data, data_length)

806 } else|if (attr_handle = ConfigCharHandle + L] i

BOT

808 f* Beceived one write command from Client on Configuration characteristic #f
809 ConfigCommandParsing{att data, data length})

810

811 - }




Parse write command and
send BLE notification on LED status

103

1. Infile Sensor.c at line 1040 =)
2. Check on the FeatureMask (line 1046) s —
1156 gnaspled: LED\DhWT™Y;
3. Ifit's the LED feature mask (line 1152) 07 Contsg Foi ey (FERTORS Mook TED, Comend, et}
4. Check on the command value. If 0x01 (casel) |.... S EvaltedOfs (12D1)
1161 PRINTF("Disabled: LED\n\r");
5. Turn ON LED3 1162 Config Notify(FEATURE MASK LED, Command, Data)
1163 break;
6. Send Notification on the Config char on the . }
Command recelved and parsed ii:i = if {::tieaturelintificatinn.Lei;;:;‘ficatinn} i
_ uint3z ConfigCommandParsingguinti 4 5 ! rﬁg&ﬁaﬂl—:ﬂ:ﬁﬂﬁmﬁ
7. Send Notfication Oﬁeﬂ&wm-ﬂ_ =her (- ii:g elseL d_Update (ENABLE)
LED statys = | wofgmemscammamsl [ | e e,
1044 'JintSE_t SendItBack = 1! 1172 break:

L1048 l |switeh (FeatureMask) |

Lys
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Enabling LED toggling

Click on “Switch” A new page will appear

o000 Verizon F 14:12 @ 7 % 72% w1 eee00 Verizon & 14:15 @ 7} 71% -

< Devices M < Devices M

Click the image to change the status

—
=
-

Not Present

2 A @
P
o & o L] &
nviromental ol Diata Cloud Loggifln Switch ssi & Battery 28
Enviromental  PlotData  Clolid Lagging Rssi & Ballery

life.augmented




Enable LED toggling

00000 Verizon LTE 10:39 @ 7 0} 86% =)

¢ Devices il

Click the image to change the status @

Write
Packet

‘1’ LED ON
‘0’ LED OFF

Notification

& 1. Tap the image on the screen

1"LED ON 2. Send BLE notification packet

# w» @ o - | ‘0LEDOFF
3. Image changes color and RED LED
toggles



LED fast blinking due to Sleep Mode

* Red LED fast toggling shows the entering/exiting to/from Sleep mode

Connection Intervals

__@ I :
Y .

Deep sleep mode

1

1

In Active Phase In Sleep Phase
LED is ON LED is OFF

life.augmented



« String “LED Notification ON” will appear as the app tab is enabled

« Each time user click on the LED icon in the BLE Sensor app, the
Write command is sent to the board and the LED toggles
accordingly (“Enabled: RGB led” = ON, “Disabled: RGB led” = OFF)

fDevice iz now discoverable with MAG: 3f:Z2c:f6:eb:da:d8
Sensor activated: 0K
Device connected

Environmental Motification ON
nuimnnmental Motification 0OFF

Jizsabhled: RGE led




Lab 4

Accelerometer embedded events detection



Example - Single Tap

1. On the board perform a
(((GB ))) Single Tap
Notification | 2. Send BLE notification
Packet g% Os  packet

‘SINGLE TAP’

NOTE: this is just an example
for SingleTap. Other events will
be displayed later in the lab!



ST BlueMS Protocol

Type Frowocol Del\gce F:naat:;e Device MAC Len Type LocalName Len Type Pwr

BlueMS 4 Bytes

o EEERERNER

ADPCM SW|tch DoA ADPC MicLevel  Proximity

mpqmnn 0xoE
Gyro

Pressure  Humidity = Temperat Battery 2nd Temp

0x04

RFU FreeFall SensFusC

7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 [N

r SensFus Compass Motionint Activity  Carry Pos MemsGes ProxGes Pedo

Beamform| AccEvent

life.augmented



&) - LSM6DSO at a glance

\1. PERFORMANCE AND FEATURE ’ [2. FLEXIBILITY: algorithm @ silicon Ievel}

* Pedometer 2.x

Accuracy: Tango and Daydream compliance g
;‘gg WeChat Precision

0.55mA current consumption is HP combo
-15% vs. LSM6DSL/M @ same performance

vew Ultra low power mode:

LSM6DSO

14uA (@100Hz ODR) Axl only ==+ FSM buid custom
P sensors for XL and
|°| :l | b m:m- Gyro

~ 4.INNOVATION |

« MEMS: Axl T-structure for mechanical
shock robustness

| - Compressed FIFO (3x)

10 patents protecting LSM6DSO
innovation

2.5x3x0.86 mm

life.augmented



Client enables Acc Event characteristic

notifications

1. Inthe file gatt_db.c go to the line 703

2. Client writes in the Acc Event Characteristic Client Configurator Descriptor
(CCCD) and Server enables notifications through the xFeatureNotfification
structure in line 714 by xFeatureNotification.AccEventNotification = true

TO5 } elsg if (attr_handle == (AccEventCharHandle + 2}) {
=
L Bl if (®xFeatureNotification.MotionMotification == false && XFeatureNotification.iNemoEngineMNotification == false) {
.?I:l'_'l‘ El 'W:lﬁl == 1% i
708 ]] lsmédso x1 data rate set (0, L5M6DS0 XL ODR 52Hz) ;
709 TErIU MIILEBIC oI oI Ty PIL REORI T, 77 ~rommrey COFF
= EnableHWMultipleEvents () ;
710 - .
711 GPIC EXTICmd(GPIO Pin 13, ENABELE);
T1z2 Config MWotlfy (FEATURE MASK ACC EVENTS, 'm", 1);
-?13 P T _“ ity —
714 { xFeatureNotification.AccEventNotification = true;
! "PRINIE [ThACCRWENE NOLLLICALION LHLORET
715
T16 } else if (act_data[d] == 0) {
717 l=zméd=soc x1l data rate set (0, LSMeDS0 XL ODR OFF);
‘ ,I 718 xFeatureNotification.AccEventNotification = false;
2/ =l GPICO EXTICmd (GPIC Pin 13, DISABLE);

life.augmented



Read Event Status and
send BLE notification

rlzaa [Fvoid MEMSCallback(vpid) {

1300

1301 ‘ lsméd=so all sources get i-:-, &all source);

1334 f* Check if the interrupt is due to S5ingle Tap */

1335 ifWﬂdﬁT' dwareFeaturePFresence.MultipleEvent) {

1336 = if (all =zource.reg.all int src.=single tap)

1337 SdkEvallLedOn (LED1) :

1238 SdkEvalLedOn (LED3) ;

1339 PRINTF("Event: Single Tap'ohr™)r

1340 LcecEvent Motify (ACC SINGLE TAP, 2) .

1341 L ) = = = In the file sensor.c

1342 - } . . .
1247 1. line 1299 void MEMSCallback(void)

Callback triggered by 1013

2. line 1301 Ismé6dso_all_sources_get
Read accelerometer status registers

3. line 1336 if (all_source.reg.all_int_src.single_tap)
Check vs. single tap event

4. line 1340 AccEvent_Notify

"I Send BLE notification

life.augmented



Visualize Single Tap Event in ST BLE Sensor

Select
PRaRT TR Tap “Single Tap” Enabled

“Event Enabled”  and hit“Select”  «Single Tap”
Select S e — ,

11 L) i— Select the event to detect { Devices i
Acc Event

11111 @ 7 3§ 85% W

Single Tap

1024.14 mBar Not Present




Event Detection

1. On the board perform a

Single Tap
2. Send BLE notification Sinale T
packet Sye 1ap.
(@)
Notification
Packet
—
‘SINGLE TAP’
Tap gently on the board # & 0 s om

)
&



Tera Term output

-

y ee  a s W COMA1 - Tera Term VT
« “AccEvent Notification ON”: el
File Edit Setup Contrgl Window Help

enable notifications on the S
— AccEvent Notification OFF
Accelerometer Event characteristic (I e I

Event: 6D Orientation

« “Enabled Slngle Tap Detection™: [HENSIEE Multiple Event Detection

user enables Single Tap event IEnahled: Single Tap Detection
Fuvent: Single Tap

detection Event: Single Tap

Event: Single Tap

« “Event: Single Tap”: the actual
BLE notification packet is sent
upon detection of the Single Tap

event.

‘, NOTE: if the phone display enters sleep mode, the notifications are not sent

ie.augmented



LSM6DSO Embedded Events

Other possible

No event

Free fall

embedded events

. Verizon 1021 @ 1 % 85% Wl

Select the event to detect

®

0“3':‘

Single tap

N

d‘.-v"?:"

Free Fall

Single Tap é Wake up ) Tilt
Double Tap .;m-:: CEr -lm‘: ;m“:"‘ G
= !
Salest g A
Cancel
e § - # = & 8 -

Pedometer

& Dovices

:
.

Lol O S

WakeUp
example

Lys
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Visualize Hardware Wakeup Event in BLE Sensor

esscu TIM 2 6:53 PM 7} 95% .

C_/ vices i
/ == | Select e -
~ i F [Evenl Enabled: Wake UD]

“Acc Event”

1024.14 mBar Not Present

s — ! K
‘. ‘; Z= g “ee
e - )
Evwromanta Sersor Fusion Dot Featyre\oaey dcogrion Mote




Event Detection

1. Leave the board still for a few seconds

2. Shake the board
3. Send BLE notification packet

(@)

Notification
Packet

—
‘WAKE UP’

Wake Up

£ Devices

r-.

7§ 96% m

s‘_‘“j




W COMEL - Tera Term VT

« “AccEvent Notification ON”’: enable
notifications on the Accelerometer Event
characteristic

Fvent= 60 Urientatlion
Disahled: Multinle Fuent Detection

« “Enabled Hardware Wakeup”: user _ Enanicd: Hardiars Wilenn
enable hardware wakeup event detection  Hdeare Daaeur
7 IZ : Hard e Wak

- “Event: Hardware Wakeup’: the actual : Hardware Wakeup
BLE notification packet sent upon e

detection of the Hardware Wakeup event. : Havduars Wakeup

Harduare Wakeup
HccEvent Motification OFF

Lys
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LSM6DSO Embedded Events

You can go ahead later and test other events...

Other possible Noevent  Freefal  Single tap
embedded events : o :

G LN

- - ",‘ .o r<3

CE

7 3} 95% -

Select the event to detect

Double Tap

Wake Up

- v

Pedometer

£ Duiens

B L

Cancel ‘5)




Lab 5
9-axis Acc+Gyro+Mag Sensor Data Fusion

life.augmented



Goal

* In this example we are going to demonstrate how to:

« Enable the embedded sensor data fusion library

* Input: raw Acc+Gyro+Mag sensor data
« Qutput: quaternions

» Scale the quaternions value by a scaling factor proportional to proximity
detection

« Send scaled data fusion information through BLE notifications packets
to the ST BLE Sensor app client

gmented



Sensor Data Fusion

1. Enable Sensor Fusion

library

. Send quaternions
information through BLE
notification packet

(@)

Notification

Sensors used by data fusion:
Acc+Gyro+Mag and Proximity




Code modifications

. Enable Sensor Data fusion library

Enable proximity sensor

Send quaternions data — scaled by proximity sensor data -
through BLE notifications packets



BlueMS

ST BlueMS Protocol

Len Type F:,frt;gﬁ' Del‘l')'ce F:nzt:;e Device MAC Len Type LocalName Len Type Pwr

ADPCM| Switch | ADPC Mchevell Proximity Lux

IRECI R N oxFE

Acc - Gyro ‘ Mag Pressure  Humidity = Temperat Battery | 2nd Temp

mnmm 10 3| R

Beamform| AccEvent FreeFall | SensFusC

4|3 | 2 | 1|0 [N

SensFus Compass MotionInt Activity  Carry Pos MemsGes ProxGes Pedo

4 Bytes

0x22

uugmemed



Sensor Data Fusion
@ @ ®

Swipe left to view the “Mems Sensor Click on Sensor Fusion
Mems Sensor Fusion Fusion” tab OK
'iasxr- #0000 Varizon LTE 10:39 fi--v-:lsax,- ‘

il A ~
- -K
/ /‘v ‘( \’JI

3570°C ‘_' To calibrate, move the board as
3250°C Not Present ! ( Q ‘H shown in the image k
To calibrate, m
shown in the image i
Ok

ove the board as
v I

1013.73 mBar 51.50 %

® w @ O - # & @ o # W oa O




Proximity Sensor
@ L2

Enable Proximity Far from Near to
__Sensor BlueTile BlueTile
e 1 @ .;;::: e 10:40 I ETE) ssxg» :)D::::; e 10:a2 @r103% EEKE.

Move your
hand far and

close to the A\
BlueNRG-Tile

Note: ONLY for rendering purposes, the cube is scaled
proportional to a clipped 30 cm distance




Proximity Sensor - VL53L1X

3rd gen ToF sensor with lens for long distance ranging & ROI selection

Product highlights

OLGA: 4.9 x 2.5 x 1.56 mm
FoV : 27°
Compatible footprint with VL53L0X

Enhanced performances:

* Full FoV ranging : 400cm+ (white target, no IR)
* Programmable FOV: SPAD zone selection — full-screen to 4x4

Cutting-edge module and silicon :
» Fastest miniature ToF product in the market up to 50Hz

* Integrated lens for longer range and better ambient light immunity
* Programmable settings to best fit customer’s application:

» Low power with interrupts for user / object detection
» Long distance ranging

 High accuracy for small movement detection

.

f

Applications

Presence user detection

* Autonomous mode with interrupts

* Low-power

* Long distance 400cm+

« PC, tablets, 10T, portable handsets, security

Obstacle detection:

» Robots: Obstacle avoidance

» Vacuum cleaners: Wall following, cliff detection
» Drones: Take-off and landing, Ceiling detection

Accurate objects distance scanning
* Vending machines: control of objects in racks
» Coins dispensers: coins counting

* Smart shelves: Consumer scanning

Lys
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Full-range Proximity R
@

“Plot Feature”
tab

Swipe left to view the

real-time data plot Pr

Select

eal-time Data Plot
&) L3 0O

Selectthe  View the

oximity  time frame real-time

data plot

Pl i i S CEREY 8 s i  § 95y .. 3 71% -
s [ a2
R e = = Select the feature to plot Select the time scale e [
i
§
Accelerometer N
! Proximit 5s S Err
H y i
g - SU I—
i |
i ) ] ) : ) Proximity (mm)
* Tele Ts:64308 Proximity:104
# Ow E O # @ o = w0 | cence # & & O




Logging Real-time Data Plot
o @ o

a After some time
Select re-click on the Select App opens your
email client

“Start logging” (ight-top corner “Stop logging”

ssec0 Verizon LTE 09:37

Click on
top right corner

09:37 & 1} 95% . T
m‘l/

Stop plotting Accelerometer

& % ooumm.
¢ Devices m

Stop plotting Accelerometer

esecc Verizon LTE

{ Devices

® 1 0% co%m

Cancel [ST BlueMS] Logger data

CeiBee

Subject. [ST BlueMS] Logger data

'3 a o - T
Enviromental PloL Doty Cloud Lbaging Act Hyent Hygi & Battes

Lys
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Start Logging

Show Debug Console

License Manager

Stop Logging

Show Debug Console

License Manager

+ ¥ Firmware Upgrade Firmware Upgrade i
g 8 % =
Settings Settings
Ts:44136 X: 269.00 (mg) Y: 220.00 (mg) Z: Ts:44136 X: 269.00 (mg) Y: 220.00 (mg) Z:
-695.00 (mg) -695.00 (mg)
Cancel Cancel i

20180319_.roscope.csv

\

.csv files attached

to the email



Sensor Data Fusion
Try static position: no drift, the cube is perfectly still

Sensor Fusion « In steady static position the acc and mag enable an accurate orientation
enabled estimate

5| e« acc vibrations and mag bias and interferences are rejected or
compensated by the motionFX library

Try highly dynamic motion: perfect tracking
In high dynamic motion the acc cannot be used, therefore the gyro is used to
update the orientation

« gyro bias is estimated and compensated at runtime by the

motionFX library

o}
3
=5
a



Sensor Data Fusion
MotionFX library

Roll, Pitch | Yaw 5 63 User

@ ] BlueNRGL it.c
: @ [ gatt.db.c
Quaternion S e
i & [ﬂ SenzorDemo_rnain.c
Headlng 3] I_.] HWadvanceFeatures.c
WA Hal
=3 Stack

] libbluenrgl_stack.as
. . E-ﬂ;ﬂ stack_user.cfg.c
Linear Acceleration B bcriia
@ I OTA
i visaLxX
= & MotionFX

»
MotionFX
Magnetometer »
Sensor
@ MotionFX100_CMOP. Keil_ot.lib

Gyroscope »
= | BlueNRGL_BlueVoice Library

r ] blueveiceADPCM_BMRGL_100_Keilfib
> /4

life.augmented

Fusion Gravity Vector

33333




Sensor Data Fusion
MotionFX library

» Roll, Pitch

MotionFX [ 2

=

™ revty veotor
=

- Accelerometer gives roll and pitch angles and the gravity
vector...but only in static conditions! (or low dynamics)

Lys
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Accelerometer »

=

Sensor
Fusion




Sensor Data Fusion
MotionFX library

Yaw

=

Accelerometer »

MotionFX |[_Z

= ST
=

Magnetometer »

=

Sensor
Fusion

=

- Magnetometer gives yaw angle and heading
...but only if tilt is compensated: the accelerometer is needed!
...and magq bias (hard-iron) must be compensated!

Lys

life.augmented




Sensor Data Fusion
MotionFX library

=y Fol, Pich | Yaw
= BT
= "

= IR
=~ L ox Focorraion.

- Gyroscope gives the new orientation based on previous orientation
...but gyro bias offset needs to be compensated for accuracy!

Lys

life.augmented

=

MotionFX

Sensor
Fusion




Sensor Data Fusion

MotionFX library

» =Y Roll, Pitch
MotionFX L4 Quaternion L

R0 = R = ST
Fusion » Gravity Vector
» » Linear Acceleration

Motion FX library provides orientation estimation plus:
- Magnetometer hard-iron offset compensation.

Accelerometer vibrations rejection.

- @Gyroscope bias offset compensation.

o -

® w a O




The gyroscope is the most important sensor in the system
...works in highly dynamic conditions when the Acc cannot be used G y rOSCO pe

...works with magnetic anomalies when the Mag cannot be used

‘—, T2 LSM6DSO
LSM6DSO is an inertial module with Acc and Gyro o e e e
- Exceptional noise performance for maximum SE .|
. . . " " (25 %3 x 083 m 00 The LSMEDSO Is a system-n-package fRaturing a 30
accuracy In orientation estimation — e
90 ug/sqrtHz acc noise density . PvemmosmnGro.  Telsoupmmnconmeas
3.8 mdps/sqrtHz gyro noise density | e e g T
E %ﬂﬁlqgmmmm %:%%m
- Extremely low-power ¢ sy e 1713 o LTy
* 650 uA peak power at ODR 6.66kS/sec with P —— ST
Acc+Gyro in high performance mode! " T e yenese s s
- B
e S e e S
mmmw LSMEDS0 Is avalladle In 3 plasticland gnd amay (LGA)
+ Embedded lemperature s2nsor package.
+ ECOPACK®, RoHS and "Greenr complant Table 1. Device summary

Lys
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LIS2MDL is digital Mag

- Exceptional noise performance and
dynamic range for maximum accuracy in
orientation estimation

« 50 Gauss dynamic range
« 3 mgauss RMS noise

« Embedded offset compensation
* Intrinsic offset is estimated and compensated
automatically
« Extrinsic offset (hard-iron) must be estimated by
host and can be compensated internally

Lys

lite.augmented

Magnetometer

r LISZMDL
’I o .augmented

Digital output magnetic sensor:

ultra-low-power, high-performance 3-axis magnetometer
Datashest - production data

Description

The LIS2MDL is an ultra-low-power, high-
performance 3-axis digtal magnetic sensor.
The LIS2MDL has a magnetic fiedd dynamic
range of £50 gauss.
The LIS2MDL includes an FC serial bus interface
that supports standard, fast mode, fast mode

plus, and high-speed (100 kiHz, 400 kHz.
1 MHz, and 3.4 MHz) and an SP1 serial standard

LGA-12 2.052.0x0.7 mm)

Features interface.

= 3 magnetic field channels mdevucanbeomﬁguredtomm

« 50 gauss magnetic dynamic range pt signal for magnetic field L

« 18-bit data output The LIS2MDL is available in a plastic land grid

5 5 . amay package (LGA) and is guaranteed to
SPINAC serial interfaces AT e

« Analog supply voltage 1.71 Vio 3.8V from <40 *C to +85 °C.

« Selectable power mode/resolution .

« Single measurement mode Table 1. Device summary

* Prog ble interrupt generat patnumber | T®MP- | package |Packaging

range [*C]

= Ewbeaied wetant LIS2MDL 20to+85 | Lea-12| T

« Embedded temperature sensor = 3 =,

« ECOPACK®, RoHS and "Green” compliant LS2MOLTR | 40tos8s | LGA-12 7"::“

Applications

« Tilt-compensated compasses

« Map rotation

= Intefigent power saving for handheld devices
= Gaming and virtual reality input devices




Magnetometer

Calibrati o
*000% Verizon LTE 10:39 @« © f Bo% m w8000 Varizon LTE 12:28 @@ % 70% M
< j < Devices M

=\

CG

To calibrate, move the board as
shown in the image k

Reset ©Froximit Ve

¥ w G o - h(/y\-

E N S Fusn 3 i 0
~

Calibration is Completed
when the icon becomes green.

Move the BlueTile with the “8

pattern” shown in the figure to
calibrate the magnetometer



Magnetometer eCompass

=nn s .
. ;= Rotate the BlueTile
€ compass I € compass ]
L d R R L ¥ & & o v % Angle-::&gzo %‘
4 : . (you can check against the
f Select Red arrow is related to phone eCompass)
Tap . , the current orientation
wor Compass of the BlueTile



Lab 6
Cloud data logging on IBM Watson

life.augmented



Cloud Logging

1. Enable IBM Watson loT — Cloud Logging
2. Send BLE notification packets on Sensor status
3. Visualize the data

= @ + } 84y >
€ Devices M
? — ?_—-—E Select the cloud provider
——— b} [ IBM Watson IoT - Quickstart h ((( 9 )))
\ I IBM Watson IoT
-5 b hboard 1£3 H .
AR - Notification GO
Azure loT _A? A ‘
Packets gl 78
Generic MQTT ‘ i I At P £
IBM Watson AR e
Aws loT focasRE g | [ E ifg
“‘i‘i'-. 23 ” .
= i&i ool = 47 '.
g Sl : | S
Pme N
\ d &
\ | 2
o et
Lyy ¢ afa]- =
oud
life.augmente:




IBM Watson loT Quickstart

2. Select “IBM Watson 1. Selectoneor —

H 7 - “ 7] . -
loT - Quickstart Click “Connect multiple features Wait a few seconds
#0000 Verizon 10:50 @ 7 3 84% > eeeco Verizon LTE 15:46 @ ¥ 0} 60y M eee00 Verizon LTE 15:51 @ 7 o} 69% M 90000 Verizon = 10:52 @ 1 % 83w
< Devices M ¢ Back 1BM Watson loT - Quickstart { Back IBM Watson loT - Quickstart < Back Cloud Data
Device Id Device Id
Select the:cloud provider BCN-034_571EBF BCN-034_571EBF
g IBM Watson loT - Quickstart ] ( Connect ) Disconnect
IBM Watson loT Battery A
Azure 10T - ST Web Dashboard ( Temperature O )4—
Azure loT Humidity
Generic MQTT Pressure 7 |'\:_
Aws loT ( Accelerometer 0 )4—
113
1. select “Cloud
= 9
Logging
( View Data on Cloud )1-
& &4l © = @D *® &4 O - D ¥ a O w D & & O - D
nuitomental__elot pata | Cloud bogaing | sce £vent  Rssi & Battry nviromenta tData  Cloud Logging cEvent  Rssl & Batter t Cloud Logging  Ace f S Ehiks

L — " 2. Click “View Data
!Im on Cloud”



IBM Watson loT Quickstart

Quickstart will You will see the Plot  Table of available
appear of selected feature features

(6)]

eec00 Verizon UTE 16:54 @ 7 p 72% . #5000 Verizon LTE 16:54 @ o R 72y - wo000 Verizon & 10:52 @ T % 83% mm) *s000 Verizon LTE 16:55 @ 7 R 71% ..
< Back Cloud Data < Back Cloud Data { Back Cloud Data < Back Cloud Data
— Biue034 | 5 Ne034 CIBEDS
IBM Watson loT Platform = l Ele? I ! . | Bue0a4 caseps
; 10
® |ast message received at 4:54:57 PM [ ® | ast message received at 4:55:22 PM
BQui ‘
Quickstart u
No sign-up required to see how easy it is to connect [3106034,03BED5 Accelerometer.Z ] T T T T T T T Blue034 _C3BED5 Temperature.Temperature
your device to Watson IoT Platform and view live 19522 Tofen tomadt
sensor data
7] Event Datapoint Value 7
2034 ( 600 2894 ]
400 Accelerometer z -1021 sapH 4
® Last message received at 4:54:31 PM 200 /
S c ro I I d OW n o4 Accelerometer Y 12 287 | f L
‘to See o u r 200 f Accelerometer Timestamp 67589 #287
Blue034_C3BEDS Accelerometer.Z - v 2 | \
= S e I e Ct e d -600 Accelerometer X 31
284 - | G-
-800 4 |
Se n SO r p | O t Ao f Temperature Timestamp 67600 2834 /
Bl Temperature Temperature 292 Bttt
400 MOt T T T T T T T T T U L L L L L L L L L)
16:54:40 16:54:46 16:54:53 16:55:06 16:55:12 16:55:18
500
I've seen my data, what next?
600
= Event Datapoint Value - . P Event Datapoint Value
PS5 a O w D ® - O CO ) o & ©O w @D L3 @ ©O = D
Envicomental  Plot Data Cloud Logaing vent  Rssi & Battery viromenta ot Data  Cloud Lagging  Act Event  Rssl & Batter Envierart fiData  CloudLogging ot sl & Battery EritGmat ot Data  Cloud Logaing  Acc Event  Rssi & Eattery

‘,I Scroll down again to

ife.cugmented change sensor data or axes



Lab 7
Voice over BLE



* In this example we are going to demonstrate how to:

- Enable the BlueVoice library for Voice Over BLE streaming

» Input: raw data from the MEMS microphone
* Qutput: ADPCM data streaming @8kHz

« Send ADPCM data through BLE notifications packets to the
ST BLE Sensor app

gmented

Goal



BlueVoice library

. 1. Enable BlueVoice library
i . 2. Send voice to the ST BLE Sensor app client
through BLE notification packet
Codec: ADIiv'I - "
P . (@) X
Notification ( ‘
A IRy Packet (
—
\ / ADPCM = )
compressed audio MEMS
Microphone




ST BlueMS Protocol

BlueMS 4 Bytes

Type Frowocol Del‘gce F:naat:;e Device MAC Len Type LocalName Len Type Pwr

RFU | ADPCM || Switch I | ADPC IMchevell PrOX|m|ty| Lux

mnnmnn

Gyro Pressure Humidity = Temperat Battery

mnnm 10 3 | .

Beamform| AccEvent FreeFall | SensFusC

4 | 3 | 2 | 10 PN

SensFus Compass MotionInt Activity  Carry Pos MemsGes ProxGes Pedo

Ox6A

OxFE

2nd Temp

life uugmen’red



Enable BlueVoice library

Add the preprocessor symbol ENABLE AUDIO to the project
1. Right-click on Release
2. Select “Options for Target ‘Release’...”

K C:BlueNRG _Tile_HandsOn\STEVAL-BCNODZV1 DK 3.0.0\BlueNRG-
Fita Edit View Project Flash Debug Perjpherals Tools
MNSad » a9 ~|« |mp=
: %‘%’* JE{ ]Iﬁl @ (=3 | 'I-‘Iw}iﬂ-. Release |E] ,&| &
= ‘% Project: BLE SensarDemo
Ei:é@ Re

- s~ Dptions for Target Release’... Alt=F7

o=

= | Add Group...

- :

e 7l dh Manage Project Rems,,,

5 L. Open hap File

73] i_-l ‘Cpen Bulld Log

@ | [EY Rebuild s target files
r @ L (& BuildTarget F7

Y/

I L'.|1l'"| Show Include File Dependencies

life.augmented m ==



Enable BlueVoice library __

In the project options:
1. Go to the tab C/C++ and then in the Preprocessor Symbols
2. Set the symbol ENABLE_AUDIO= 1 and then click on OK

l Optians for Target ‘Refease’ E
Devics | Target | Output | Listing | User | W*Il‘m | Linker | Debug | Lhities |
~ Prepmecessar Symbols
s I’-I:SMPS_JNDUCTDH_IGJH SEND_N QUATERNIONS=1 ADC_2411=1 DEEUG:'[lﬂm l
Unigefine: |
[
Language / Cods Generstion
Il | I Eecteonylode I SmctANSIC boifl
| | Optinization: [Level 3(03) ] I™ Enum Container always int [ Wamngs <]
i W Optimize far Time ™ Plgin Charis Signed [T Tt Moz
| I~ Spli Losd and Store Muttiple ™ Read-Only Postion Independent [ No fuls Includes
! P e SFE Setior e Fundion [ ReadWrite Postior idependert. [ €39 Mods
|
k hcﬂuda | Sutdnc oy Alibrary\Blue NRGT_Perph_Drivertinc:, o\ v \Libran\CM SIS Device S ThBiue _l
| ) MEC
| Cortrols
:‘Ca!'ltﬂ.lﬂ' 9% ¢ —<pu Cottex-MD g 012 Ltime —apes=nterwork —split_sections < ./ finc - - |
w A £ Ubrany/Blue NRG 1 _Periph_Driver/ine - |
=l .

life.augmented oK I Cancel Defaults. I Help |
(S 1



BlueVoice: voice over Bluetooth LE

Select Speak close to .
“BlueVoice” the BlueNRG-Tile
}n;ev::: TE @ E3 E }n;ev::: uE 10:43 T E] 15 .:,;:::: LIE 10:42 CRELE R E ( ( ‘
: :‘::::Mt : :::IEhMt Codec: ADPCM
$1 Bluevoice l $1 Bluevoice ] SaMDii;rg'req:BkHz o MEMS
g — rgp—— ek Microphone
a Compass a Compass
D Resia Batry 0 Res & Batry (if the mic captures the audio from
PR the phone speaker, a very high
pitch sound can happen!)

Voice will be streamed over BLE
You will hear it from the phone

Av' " Do not silence your phone,
must NOT be vibration only!

Tap
Ky

life.augmented

More



Voice over Bluetooth LE
.................... B

Generic Attribute “ Generic Access ‘ “ . . |t,S d VendOI‘ SpeCifiC
‘ GAP configuration

Profile (GATT) Profile (GAP) .
( Service!
Central (g Peripheral
(Master) (Slave)

GATT configuration

Attribute Protocol I Security Manager

Logical Link Control and Adaptation Protocol

Audio: exported by the Server

© m through 2 dedicated

. BLE characteristics

Bluetooth Low Energy Stack j Characteristic Voice Stre.ammg over BLE:
Audio @8kHz

T Codec: ADPCM
1 | Bitrate: 32kbps

Link Layer I Direct Test Mode

Physical Layer

1

|

I

i

|

Host-Controller Interface i
7 I

|

|

]

i o o o T o o o S o o

Lys
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BlueVoice ADPCM - Audio 8kHz

e
il

Advertise

Central (((ea ))) ¥ ’“-;@

Advertise

Discovery Mode

Connect Request

No acknowledge required for Notifications: )
Connection created

- OK for Audio streaming H — o Peripheral-to- Audio can be
.. Notification :

« Minimal Latency = Central half-duplex

+ Optimal Bandwidth communication

Notification

Voice Streaming Connection Connection Connection ~ Connection Connection
Event Event Event Event Event 2 k t / t

« Audio Format: PCM 16 bit @ 8 kHz 5 E i - < < ” packets/even
. ADPCM Compression @ 32 Kbps: | | ... ... 20 bytes/packets

Low latency and low complexity ng?io 100 events/sec

e

 Side Information at low data rate | k——————— e > _

enhances error resilience 10ms 160ms t

Connection interval ADPCM Synch interval

Lys 32kbps

life.augmented

I Audio Data Packet, 20 bytes B Sync Data Packet, 6 bytes




BlueVoice architecture

“Packetization” 5 5 User

] BlueNRGL _ite

i \ il |_1 gatt_db.c
ST d_lgltal MEMS BlueNRG-2 I}]--D SENSONG
mlcrophone @ |1 SencorDemo_main.c

I C] HWadvanceFeatures.c

. PDM - -1 Raw Data ar L T s S
Audio PDM to PCM . ADPCM , Server - TX =5 Stack
> Acquisition conversion | Compression 9B|llet%lﬂ!rl\ 1] libbluentgl stack.a
[ - ‘) E | stack_user cfg.c

— |1 liberypto.a
\ B 0 VIS3LiX
Bitrate 32 kbps K = & MationFX

| | MotionFX100 CMOP Keil ot lib
= 2 BluehRGL_BlueVoice_Library

Fm i - ] i 7 |1 bluevoiceADPCM_BNRGL 100 Keillib
S De-Packetization — s
Smartphone app (ST BLE Sensor app) &

wrj Client - RX Raw Data Audio PCM Serial Audio )
—[ \ )

I} ﬁ - ﬁ Out
GBBIuetongg Decompression USB, 125, ...

life.augmented



Lab 8
Over-The-Air (OTA) FW upgrade



Flash memory layout

0x1007E800
0x1005F800 BLE_Chat_Server_HigherApp_OTA.bin ﬁ
BLE_SensorDemo_ (((ea ))) %\
LowerApp_OTA
0x10040800 -—
BLE OTA_ResetManager
0x10040000

r REMEMBER TO LOAD THE BLE OTA Reset manager!!!

life.augmented



0x1007E800

0x1005F800

0x10040800

0x10040000

e [
¥ £ O
'0.- ‘, s ¥

BLE Chat Server
HigherApp_ OTA

Empty

BLE OTA_ResetManager

Once OTA is completed...



Click on the top right
corner

—
&
»

25.20°C Not Present

)

996.01 mBar 4710 %

- o - eoe

Mems SensorFusion Plot Data Acc Event More

Lys
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Select “Firmware
Upgrade”

Start Logging

Show Debug Console

( Firmware Upgrade )

Settings

License Manager

OTA FW upgrade (1/2

Select your remote

Cancel

repository
Wl TIM = 16:29 <} 23%W
Browse Cancel
Q Search
Locations

% iCloud Drive

&. Google Drive

[E Dropbox — Personal )

E Recently Deleted

Favorites

Tags

® Red
@ Orange

Yellow

Green

Recents

Select the binary file

RV 16:33 7% 20%0
£ Locations Tile_DK1.1 Cancel
Q Search

Sorted by Name ¥

Fe
@ @
= -

BLE Beacon U BLE Beacon U BLE Chat_Serv
se OT..anager se OT..anager er_Hig...pp_OTA

3/z26/19 afzene 3/26/19
230 KB 82 KB 76 KB

B B =

BLE_Chat_Serv  BLE_Chat_Serv BLE_Chat_Serv
er_Hig..pp_OTA er_Low..p_OTA er_Low..p_OTA
3/26/19 326119 3/26/19

214 KB 214 KB 76 KB

@

@ @

P

159



OTA data transfer
begins

BLUENRG OTA
Version: 1.0.0
Mcu type: BLUENRG

4 N

k 2048/75984 bytes j

Flashing the new firmware

Lys
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Click OK as
completed

Upgrade completed

The board is resetting

‘ Ok '

( @ BlueNRG1_Chat )
0195AE3B-25C2-37E9-...

PM1V100
C0:6E:33:38:36:30

OTA FW upgrade (2/2)

Re-Connect to
BlueTile, now running
a new application



Customizing your design




STEVAL-BCNO02V1B Block Diagram

Matching
Network’

BALF-NRG-02D3

Integrated balun

UART RXline

IRQ ADC
LIS2MDL BlueNRG-2 RGBLED
magnetometer Bluetooth 5.0 Network and

12C
LPS22HH - Application processor MP34DT05-A

barometer microphone

HTS221 kHz
Relative Humidity & Temp. 12C connector

LSM6DSO 12C
accelerometer + gyroscope

: VI753L1 - I2C
time-of-flight proximity

Lys
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Enable/Disable Sensors & Libraries

- Dedicated structure “FeaturePresence” for enabling/disabling
sensors & libraries individually. File sensor.h

typedef struct {
bool AccelerometerGyroscopePresence;
bool MagnetometerPresence;
bool HumiditvTemperaturePresence;
bool PressurePresence;
bool ProximityLightPresence;
bool iNemoEngine:
bool Pedometer;
} FeaturePresence;

- SensorScan() function set each field of the structure to false or

t F'I /{ Check sensor list
rue. File Sensor.c Sensoxascan (1
// Configure discovere d sensors

if (xFeaturePresence.PressurePresence)
Init_Pressure Temperature Sensor();
. if (xFeaturePresence.HumidityTemperaturePresence)
Disable the unneeded toss_pamsaiey Sensor ()
if (xFeaturePresence.MagnetometerPresence)
. . . Init_ Magnetometer():
Sensor for Optl mIZI ng the if (xFeaturePresence.lAccelerometerGyroscopePresence)
Init_ Rccelerometer Gyroscope ()
if (xFeaturePresence.ProximityLightPrezence)

m power consu mption ! Init Proximity Sensor():

f/ Configure sensors in low power mode
lite.augmented SensorsLowPower () !



BLE timings

- Advertising intervals:

« Dedicated APl aci_gap set discoverable(Advertising Type,
Aavertising _Interval _Min, Advertising Interval Max, ... )

* In file sensor.c

- Connection intervals:
- Dictated by the Central device. Peripheral has no full control on this.

- Notifications frequency

» Dedicated Virtual Timers (mapped on HW physical timers) for different
functionalities

« Timeouts defined in sensor.h

#define BATTERY UPDATE RATE 1000 // Fixed ODR € 1 Hz
:— #define ENV_SENSCR_UFDATE RATE 100 // Fixed ODR @ 10 Hz
, #define MOTION SENSCOR UPDATE RATE 40 // Fixed ODR @ 25 Hz
life.augmented



HW modifications

* In this case redesign is of course necessary

- Schematics and Gerbers files:
+ online at www.st.com/bluetile #1%2  Functional description

The table below shows the GPIO configuration table where each 10 pin is associated with related functions._

Table 129. 10 functional map

* BlueNRG-2 pin mapping

Signal | Type | Signal ‘ Type | Signal
Check B I N RG 2 DS T bl 1 29 100 Vo GPIO D i UART CTS | 1O SPI LK 0 CPUCLK
¢ ec ue - at 1able 101 1o GPIO 1 0 UART RTS | 1D SPI_CS1 | PDM_DATA
102 | wo | ero2z | o | pPwMo | © | sPLouT O | PDMCLK
103 | wo | @03 | o | PwMi | 1 |  SPLIN ] .
104 1o GPIO 4 | UART RXD | 1O 12C2. CLK 0 PWMD
105 | wo | erios | o | uaRTTXD | 1o | 12c2 DAT ) PWM1
106 1w | R0 o UARTRTS | 1D 12C2_CLK I | PDM_DATA
o7 | wo | GPIG7T | | | UART.CTS | WO | 12c2 DAT o | Pom_clk
108 | wo | @Piog8 | © | UART.TXD | WO | SPLCLK I PDM. DATA
109 [ wo | eros | 1 | swok | 1 | sPN ) XO16132M
1010 w | ePIo10 | SWDIO o SPLOUT 0 CLK_32K
1011 i | eGP0 | UART RXD | 11O SPI_CS1 0 CLK_22K

1G12 aD GPI12 = - l{e] 12C1_CLK - -
’I 1G13 QD GPI 13- | UART_CTS l{e] 12C1_DAT - -

life.augmented 1014 1o GPIO 14 o 12C1_CLK t{e] SPI_CLK - -



Quick recap



DK 3.0.0 SW architecture

SensorDemo

s ™
LEstack ) owsis

Library )

.

p
BlueNRG-2_Peripheral_Driver Board Support Package

. Drivers J

~

/
BlueNRG-2
J
)

. HW Components

p
STEVAL-BCNOO2V1

Lys
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STEVAL-BCNO02V1B Block Diagram

- R
Integrated
antenna
Matching
Network’
BA RG-02D
TES
LSM6DSO e ; % UART RXline ar butto
accelerometer + gyroscope h IRQ ADC
» : ~ = R
agnetomele |R L 5
D H on P34D10 &
400 1.6 MHz
kHz _
Re e dity & [emp O O
\ -

Lys o
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State | Avg power cons .
Power consumption

stand-by 25uA
advertise 250ms 170uA
Battery notification 0.25mA
Environmental / AccEvents / LED control 0.3mA
Motion FX (Inertial) 1.4mA
BlueVoice 3.6mA
Motion FX plus Time Of Flight 8mA
BCN002V1 3V
60 [— ol I I | I I [ —
o o istantaneous
g co n nected o average
@ o
50 — 9_ g —
o =
S I
Q
40 — 6 —
5
g 30 — —
5]
3 20 environm. | N4ToF Accevent LEDctrl BlueVoice battery | -
0.3mA ‘ ‘ e |“ 03mA  0.3mA | 36mA 0.25mA
iy
10 ” i l 0 . —
|
° adverti motionFX dverti ‘stand-by
aavertise aavertise stana-by
‘ 1.4mA
,I 170uA | | | | | | | 170uA | | 25UA |
10 20 30 40 50 60 70 80 90 100

life.augmented
time [s]



Battery lifetime: CR2032

_ Avg Power Cons | Battery lifetime

stand-by 25uA 8800 hrs / 367 days
advertise 250ms 170uA 1294 hrs / 54 days
Battery notification 0.25mA 880 hrs / 37 days
Environmental / AccEvents / LED control 0.3mA 733 hrs / 30 days
Motion FX (Inertial) 1.4mA 157 hrs / 6.5 days
BlueVoice 3.6mA 61.1 hrs /2.5 days
Motion FX plus Time Of Flight 8mA 27.5 hrs

Lys
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The end: Q&A



Virtual COM driver installation Win7

life.augmented



I"" EhafdRia] Fledye

E K miinicon

afl Program

life.augmented

2. Select Device Manager

Open the Windows Control Panel

1. From Start Menu select Control Panel

ng@ v Control Panel v All Control Panelltems »

Adjust your computer’s settings

¥ Action Center

n Bang & Qlufsen Audic Contral Panel

Date and Time

!! D[‘;pla}'

Ia Fonts

Intel® HD Graphics

[ Location and Othisr Sencors
Naotification Area Icons

-.'@ Power Options

%3 RemoteApp and Deskiop Connections
1B Syctem

IE Windows CardSpace

Bl Windows Update

=1 Administrative Tools [ AutoPiay
5'-&@ BitLocker Drive Encryption l:Yl Caloald - i

% Default Programs

'@ Ease of Access Center

i Device Manager

i Getting Started QG- HomeGroup

"__3_T| Internet Options || Jva
M Mazil (32-bit) # Mouse

M Ferformance Information and Toals I! Personalization

[ Prograns and Features & Recov Ery
4 Sound .1-31 Speech Recognition
J_ Taskbar and Start Menu

48 Windows Defender

[ Troubleshooting

ﬁ' Windows Firewall

View by:  Senall icons =

b Backup and Restore
B Credential Manager
E!'.a Devices and Printers
E.' Folder Optiens

% Incexing Options

Z2 Keyboard

:E Network and Sharing Center
=] Phons and Modem
8 Region and Language
@ Sync Center

3'!, User Accounts

Lﬁ Windaows Mehility Center




Open the Device Manager

1. Look for Other devices and right click and then select
Update Driver Software...

i Davicr:- Manager
Fle Action View Help

&= I EH >R

[l SCZ20153 19017
# g Batteries
& & Computer
= Disk drives
.'% Display adapters
i % DWD/CD-ROM drives
®
H

| N

5 Human Interface Deviess
& IDF ATA/ATAPI controlers
E -§ IEEE 1334 Bus host controllers
m% Imaoing devices
#== Keyboards
&l 5] Memory technology driver
Mice and other pointing devices
{5 Modems
& Wi Maritars
= &F pztwork sdapters
| 5-—--#.; Cisco AnyConnect Secure Malility Client Virtual Miniport Adapter for Windoas x84
¥ Intel(R) 525 79LM Gipabit Netwark Connection
_ih IntEi(R) CentrinolR) Advanced -1 6205

Bl ﬂ@ O'Ener dewices

&2l KB Fortable Dy

=] "Fpods(ccma M"

Bl . Processors Smfﬁrharma:hmges
# E-: Security Devlm ) .

E@Sensnts ! ; o
,I % Sound, ideo ST _I

1M System devices
life:augmented ILsundhes the Updat= Driver Software Wizerd for the selected device.




Look for the VCOM Driver

1. Select Browse my computer for driver software
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Look for the VCOM Driver .

1. Click on Browse button and go to the folder “\STEVAL-BCN002V1 DK 1.0.9\PCDriver\Virtual
COM Port Driver”

2. Click on Include subfolder and then on Next

# update Driver Software - STMicroelectronics II_EI

e —

= Letme pick from a list of device drivers on my computer
Thislist will shiaw installed driver software compatible with the device, and all driver softwarsin
the same category as the device,

Lys

s griantad next || canel |




Allow the driver installation

1. Click on Install driver software
anyway

® 2. Installation starts

3 ® update Driver are - STHiD ectromi
the publisher of this driver software J i Update Driver Software - STHicroelectronic
s yebsite for updated driver software far yaur e L [ | )

l -) Don't install this driver software
mn‘mlﬁ check your manufecturer’s

Only, sftwvare obtained from your manufaciurers website or disc,
Limg-sedmﬂnw Frn ﬁwmmyhamywm or steal infarmation:
"
v| seeceials.




1. Installation completed

2. Device is in the COM Ports list

# update Driver Software - STHicroelectronics Virtual COM Port (COM107) x|

I} ‘Driver Softwara - nics Virtual COM Port (COMI0T —
& L e (Comen) 5y

@ o0 DS E RS

Windows has finished installing the driver software for this device!

STMicroelectronics Virtual COM Port

-

‘_ Done! Now please go back from here!

> /4
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Bl SCZ201531917

=) @ Batteries

-4 DVD/CO-ROM drives

+-4 Human Interface Devices
g o IDE ATAJATAPI eontrolers
B i IEEE 1354 Bus host controllers
- 25 Imaging devices
Gl — Keyboards
E -E7] Memory technology driver
& 4 Mice and other painting devices
E u;J Modems
& B Monitors
ES: Network adapters

|- ¥% Cisco AnyConnect Secure Mablity Chent Virtual Miniport Adapter for Windows x64

- & Intel(R} 82579LM Gigabit Network Connection
- B* Intel(R) Centrino(R) Advanced-N 6205
- &* Microsoft Virtual Wik Miniport Adapter

e S Ry
1" Ports (COM &LPT)

-T2V ECP Printer Port (LPT1)
T? STMicraelectn I
Drorpecare
[ Security Devices
2 Sensors
-/ Sound, video and game controllers

W System devices

¥ @ Universal Serial Bus controllers

3




Virtual COM driver installation Win10
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Open the Windows Settings

Photos

fesinci 1. From Start Menu select Settings

Pubfisher 2016

2. Select Devices

Skype-for Business 2016

Sticky Notes

Windows Settings

STMicroelectronics

| Find a setting A

Symantec Endpaint Protection

TechSmith g @ @ R

Ters T System Devices Network & Internet Personalization Accounts
Eregee Display, notifications, apps, Bluetaoth, printers, mouse Wi-Fi, airplane mode, VPN Background, lock screen, Your accounts, email, sync
power colors work, other pecple

Vieice Recorder

- ~
(%"L a IEI R_/

Time & language Ease of Access Privacy Update & security
Westher ] arrato e R - Windaws Undate recove
Speech, region, date Marrator, magnifier, high Location, camera Windows Update, recovery,
contrast backup

r— : Websites

life.augmented




Open the Device Manager .

1. Select Device manager

:-_.‘q_u Device Manager
File Action View Help

2. Select Other Devices and Unknown device €»miB]

==
v M SCZOWL958T

Settings > g .::’dia_?npm.an’d outputs
» teries
» ) Bluetooth
& Home Add devices » I Computer
v e Disk drives
| Find a setting - | Add a device » [ Display adapters
+ » " |DE ATA/ATAP| controllers
Devices 5 o3 Imaging devices
. » = Keyboards
&3 Printers & scanners Other devices » [3 Memory technology devices
» [ Mice and other painting devices
| =@ Connected devices Composite MSC €DC » [ Monitars
== v B Network adapters
+ Bluetooth =™ Pl Device I Blustooth Device {Persanal Area l_\.lEI:wu_rkJ
Q Bluetooth Device (RFCOMM Protocol TDI)

[ Cisco AnyConnect Secure Mability Client Virtual Minipart Adapter for Windaws x54

0 Mouse & touchpad 5 Intet(R) Dual Band Wireless-H 7260

) (5 {ntel(B] Ethernat Connection 1218-L
Typing Download over metered connections ”“ E
® To help prevent extra charges, keep this off so device software iﬂ Unknown device
AutoPlay {drivers, info, and apps) for new devices won't download while 2, WS RE:
you're on metered Internet connections. w # Parts ([CTM &i__m']
B use @ off E Intel(R) Active Management Technology - SOL (COM3)

f USE Senal Device (COMS)
» [ Prirt queues

Related settings > Bl Processors
» By Security devices
Bluetooth settings ? l Software devices
» Wy Sound, video and game controllers
‘ Devices and printers o & Storage controllers
,I » E= System devices
[ Device manager » i Unrversal Senal Bus controllers
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Update Driver Software

2 Device Mansger 1. Right click and then select Update Driver Software...

File Action View Help
an mEd HE B EXE .
- & scrowisser 2. Select Browse my computer for driver software

» E& Audiciinputs and outputs

» 239 Batteries "
» E) Bluetoath

» B Computer

v Disk drives

» [ Display adapters

» =@ |DE ATASATAP| controllers
h, Imaging devices

B Update Driver Software - USE Serial Device (COME)

How do you want to search for driver software?

-

» 2 Keyboards

» [3 Memory technology devices —> Search automatically for updated driver software

» ﬂ Mice and other pointing devices Windows will search your computer and the Internet for the latest driver software
s [l Manitois for your device, unless you've disabled this feature in your device installation

~ [ Network adapters settings.

= Bluetooth Device (Persanal Area Network)
Bluetooth Device (RFCOMM Protecol TDI) .
?ﬂ Cisco AnyConnect Secure Mobility Client Virtual M —> Browse my computer for driver software
5! Intel(R) Dual Band Wireless-M 7260 e Locate and install driver software manually.
? Iriti:[(R] Ethernet Connection 1218-Li
~ B Other devices
E Illnv S ‘ = -
- ﬁ pﬂf']': | Update Drver Software.,,
» =l Prir Ehsable
» P sl

« B seA Scan for hardware changes

Properties
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Look for the VCOM Driver

1. Click on Browse button and go to the folder

“\STEVAL-BCNO002V1 DK 1.0.9\PCDriver\Virtual COM Port Driver”

2. Click on Include subfolder and then on Next X

& B Update Driver Software - USB Serial Device (COME)

Browse for driver software on your computer

I Search for driver software in this location:

l On\STEVAL-BCMNO02VL DK 3.0.00\PCDriver\Virtual COM Port Driver v| | &mh |

[ Include subfolders ]

—> Let ime pick from a list of device drivers onmy computer
This fist will show installed drver software compatible with the device. and sll driver
sgftwate n the same categary as the device.

| Cancel |

life.augmented




M Device Manager d O n e

File Action View Help
s @ EEE B EX®

v A sczewleser

b J|| Audio inputs and outputs
Q Batteries

9 Bluetooth

[ Computer

= Disk drives

s [&l Display adapters

= |DE ATA/ATAPI controllers
i3 |maging devices

1. Installation completed. Device il

ﬂ Mice and other pointing devices

is in the COM Ports list et

@ Bluetooth Device (Personal Area Network)
@ Bluetooth Device (RFCOMM Protacal TDI)
3 Cisco AnyConnect Secure Mability Client Virtual Miniport Adapter for Windaws %84
I? Intel(R) Dual Band Wiretess-N 726D
@ Intel(R) Ethernet Connection [218-LM
~ |7 Other devices

n Processors

Done! Now please go back from here!
0y Security devices

I Software devices
: J|| Sound, video and game centrollers
5 & Storage controllers

= System devices

‘ ,I 3 i Universal Serial Bus controllers
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ARM Keill MDK Installation
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Kell ARM MDK Installation

- Download and install the tool from the following webpage:
» http://www?2.keil.com/mdk5/

armeckeiL

fr Products Download Events Support

Home / MOK Learning
: : &® Platform
MDK Microcontroller Development Kit
Keil® MDK is the most comprehensive software development % :
. . & Quick Links <’ Software Packs
solution for Arm®-based microcontrollers and includes all
companents that you need to create. build, and debug embedded = Getting Started = Device List
applications. = Online Manuals = Evalyation Boards
[ ] = Middleware = MDK v4 L egacy Suppaort
s Compare MDK Editions = Third-Party Scftware Packs
Update: MDK v5.27 available, containing enhancements for e Pl ST R = Bubiic Sofiware Packs

multi-core debugging and the latest Arm Compiler 8.12.

Lys
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Keil ARM MDK Configuration

Download and save on your PC the .zip file “Keil. STBIlueNRG-2 DFP.1.0.1.zip” from
the following webpage: https://www.keil.com/dd2/stmicroelectronics/bluenrg 2/

ArmekeEiL

f Products Download Events Support Videos

Productinformation Hame /| MDKS Device List / BluaNRG-Z
Product Overview

Supported Micrecontroliers

Shows and Seminars STMicroelectronics BlueNRG-2
Technical Support Hz, , 256 kB ROM, 24 k8 RAM  Quick Links
Support Knowledgebase

= Board List
Product Manuals High performance, ultra-low power ARM Cortex-M0 32-bit based
Application Notes architecture core - Upgradable BLE stack (stored in embedded = Software Packs
Discussion Ferum Flash memory, via SP1) - AES security co-processor - Low power = MDK Version 5

modes - 16 or 32 MHz crystal escillator - 12 MHz ring oscillator -

Legacy Suppert

Software Downloads 32 kHz crystal oscillator - 32 kHz ring oscillator - Compliant with
Product Downloads the following radio frequency regulations: ETSI EN 300 328, EN =3 (SRR
File Downloads 300 440, FCC CFR47 Part 15, ARIB STD - Operating
temperature range: -40 to 85 Celsius

Other Information Silicon Supplier
Books > Core Hz = STMicroelectronics ‘
Links Yl

. > Memory 24 kB RAM, 266 kB ROM
SO T Device Family Pack E&

Corporate
Support for this device is comtained in.

Sales Channels
Distributors STMicroelectronics BlueNRG-2 Series
Device Support
ie.augmented




Keil ARM MDK Configuration

- Open Kelil uVision5 IDE

* This is the main GUI ﬂmf‘“; T —————— " ~|=|m| B |

@ A @2 o]t o] [ PR RA N EE M| B owomaconon A #A] 0 0 O @lEE Y|
isOnes| X B
BT =@

=] Project _@Euah | ¥ Functiems | Oy Femplates
Said oo -

*
) uitd Sutput | T Find in Filzs | Fervser

stopped.




Keil ARM MDK Configuration

- Open the Pack Installer
- Go to Project->Manage->Pack Installer

B“Pﬁﬁﬁﬂ . ! ! || | . - — - el
New pVision Project..,

New Multi-Project Warkspace..,
Open Praject...
Qase Pru.}.eﬂ
Export :
| ‘Manage Bl & Project ems..
@ Mulki-Projec Wotkspase
Select Device Tor Targst .. @, RurTaoe Eiiroamenti
il e SltFr % Selea Softwars Packs..,
AN Options.,, : W Aeload Saftware Packs
Clean Targets I& Packinstallet...
L] -Bulld Target EZ Migrate ta Vermion 5 Formatil.
|24 Retinild afl target files
L Batch Bulld,.,
= Transfate.,. CHf=F7
it | Stép build

Lys
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Kell ARM MDK Configuration

4| oevers) [ESTRE o] [a] ks | Eamples | i
| seareh: - X Pack Action Description
[ Device 7 e [ Device Specific 0 Packs No device selected
=1 Al Devices 23 Devices F-Genetic Racks
@ ARM T Devices - ARMECMSIS & U to dat= | CMSIS (Cortex Microcantroller Software Interface Standar
- Keil:ARM_Compiler € Upiodsts | Kel ARM Compiler extensions for ARM Compiler 5.and Al
1 I n th e P a c k I n St a I I e r \ - Keil:MDK-Middleware | €9 Un to dat=__ || Middleware for Keil MDK-Professional and MDK-Plus
|
. amm |

2' GO to Fi Ie'>|mp0 I‘t 88 Pack Installer - CilKeil vSVARMIPACK

Hle| Packs Window Help
Befrach
Import..
Import from Falder = )('.E
! Exit
. =" Al Benres
i
ol | -!'I,
Output 2%
[Refresh Pack deccriptions
r !
,I | 2ction 0 teft): Update Pack hitt kel com/pack/NXP.LPC54018_DFF pdsc | [ONUNE
life.augmented



Keil ARM MDK Configuration

1.0pen the previously saved .zip file “Keil.STBlueNRG-2_DFP.1.0.1.zip”

&) Impart Packs - L2 |

@Q,| L » Computer » O5Dik(C) v BlueNRGZ_HandsOn » KelMDK »

=¥ || Search KeithioK 5

Organize Mew folder B m 0

+ 7 Favarites ) 3 ‘ Date madified Type
B Desktop KE] Keil. STBlueMRG-2_DFP10.0zip ZITAMBLA P zip Archive

W Downloads

= Recent Places

4= Librares
» [E| beeuments
o o} Music £
= Pictures
B videas

a Computer
i &L, OSDisk [C4)
" e REmMovable Disk {04

It ﬁ" Metwark -« [T ] b

File name: - | Pack - PACK ('aip”p |

"I _%en [v| | Conce |

life.augmented




Keill ARM MDK Configuration

/1
@8 Pack Installer - C\Keil ySVARMPACK. 2 |

Fie Packs Window Hep

1. Once the Device Support pack 2 ook St STHuetns:

| Devices | Boards | +| 4] Packs | Bamples | Ea

has been installed, on the = HE s 2
Device /| Summary - Device Specific 1 Pack STBlueMRG-2 zelected
D Vi I H t H th I ft I 4 ¥ Active-Semi 4 Bevices j - Keil:5TBlueNRG-Z DFP |4 Upto mﬁ_‘ STMicroelectranics BlueNRG-2 Sefes Device Support
e ces I S I n e e C o u m n # @ Ambig Micro 6 Devices = Genenc 21 Packs
# ¥ Amiccom (T Devices - ARM:AMP Instali Software components for inter processor communication
S e I eCt th e Ve n d O r E. @ Analog Devices 12 Devices ARMECMSIS ;?slz_u_giate CMSIS (Cortex Microcontrolter Saftware Interface Standar
= ¢ ARM e ARMCMSIS-Driver Va..| & Instal CMSIS-Driver Validstion I
= - F- ¢ Cypress i - ARMzCMSIS-FreeRTOS | < Installe Bundle of FreeRTOS for Cartex-M and Cortex-A
STMicroelectronics )l el < e L
- ¥ HDSC 30 Devices ARMumbedClient 4 Install ARM mbed Client for Cortex-M devices
@ ¥ Holtek 123 Devices ARMumbedTLS _g%_}rftf_ﬂ iﬂm?_eiryp;tpﬂhi: and SS[_JLLS library for Cortex-
- 9 Infinean 166 Devices ARM:rinar f@ Install mbed OS Scheduler for Cortex-M devices
- @ ¥ Lapis Semiconductor {7 Devices - Huawei:Lite0S _g_?_frﬂnﬂ Huawei LiteOS kemel Software Pack
2 G o t o ST B I u e N R G - 2 S e r I e S E- 9 Makim PR = KeilstRM_Compiler | Update Keil ARM Comipiler extensions for ARM Compiler 5 and Al
" T ¥ MediaTek {7 Davices Keil:Janssan 7@7 7&5}.&1 Janzson is a C [ibrary for encoding, decoding and manipu
F % Microchip 381 Devices - Keil:MDK-Middleware |3 Update Middl for Keil MDK- ional and MDK-Plus
a n d se I ect ST B I u e N R G - 2 ar @ Micrassmi B Devices = PP | Instali [wlP is & light-weight implementation of the TCP/P protc|
w ¥ MindMotion 2 Dievices - Micnum:RTOS % _Install Micrium software components
@ % Mordic Semiconducter |13 Devices - Oryx-Embedded: Midd... Middleware Package (CycloneTCP, CycloneSSL and Cyele
- % MNuvaten 487 Devices #~RealTimelogic:Sharks, | SharkssL-Lite s a super small snd super fast pre—:omp’;;(
. . . w P MEP 1719 Devices - RealTimetogic:SMQ Simple Message Queaes (ShQ) is an easy to use 16T publi
3 i N OW |t Wi I I S h OW N g re e n B % Redginesignals TP i rediogheredBiocks-Si... | Install C Target Library for the redBlacks WYSIWYE SiL Simulator
- @ Renesss 4 Devicee - rt-threadurtthread 4 Install rt-thread software components |
14 99 . @ Sificon Labs 530 Devices i = VOGITECH:RSTL_AR... |4 Deprecated | Il DEPRECATED Product il YOGITECH FRSTL Functional §
U p to d ate G copiy on Peuioc - YOGITECH:fRSTL ST... @ Deprecaied | I DEPRECATED Product |l YOGITECH FRSTL Functional 5
@ STMicroelectronics | 1056 Devices i
1 1% STBIUCRG Series |1 Device
STElueMRG-1 Series |1 Device
P k I t I I STBluehRG-2 Geries 1 Device 1
4 CI th ac ns a er % STBluehRG- 1 Device ]
- ose e 7 77 STMBZF0 Series 111 Devices
§ STM32FL Series |85 Devices
4% STMB2E2Series |46 Devices ol Kl il
Output X
r pdatz avallsble for Kell:MOK-Middiewarz (instatled: 74,1, avallable: 7.5.0) -
, I Refresh Pack descriptions
Updatz available for ARMCMSIS (installed: 5.0.1, availabile: 5.2.0 =
Wpdatz available for KelltARM_Compiler installet 1.3, available: 1.5.3) |i|
hzw:.uugmemed IUpd‘aP_ availsble for Kell:MOK-Middlewars (installed: T 4.1, avallable 7.5.0) -

[[Ready lonumE




BlueNF

‘M MDK

G-2 free license for Keil AF




BlueNRG-2 MDK license Activation

* You can refer to the following webpage:
* hittp://www?2.keil.com/stmicroelectronics-stm32/mdk

- Note: it is mentioned STM32L0 and STM32F0, but the same
procedure applies to BlueNRG-2 device

57
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BlueNRG-2 License Installation 1/6

LOnen

L '.El Run s administratar ]
AL L L L =L —
Open file location
7-Zip 3

CRC SHA »
[&f  Edit with Notepad++

- Login with an account that has administration rights.

] WinMerge
Pinte Taskbar
Pin to Start Menu

Restore previous versions

- Right-click the pVision icon and select Run as i »

Cut

Administrator... from the context menu. M -

0 Default Pregrams

¢ Google Chrome Rename

£ IntemetBrplarer. | p L b

R Keil wisionS e

B Keysight 145854 Documents

Keysight Connection Expert
| Licencetxt

m Licensepdf

(8] Skypefor Business 2016
1 STMECUbEMY

B sTM32CubeManitar-RF
* STM32CubehX

4 Windows DVD Maker

W5 Windows Faxand Scan

9 Windows Media Center

Windows Media Player

ﬁ] Windows Update

r 1 Back
' I | Seorch prograrm ang filss
e
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Pictures

Music

Computer

Contral Panel

Devices and Printers

Default Programs

Help and Support




BlueNRG-2 License Installation 2/6

¥4 ©2Program Files (x86)\5TMicroelectranic

[File | Edit view Project Fiash Dbt

1.0pen the dialog File — License Management...

i

New., Ctri<N

[ Open Ctri=0

=

Close
Save Cirl-5
Save As.,,

i saveal

‘Device Database..,

[

License Mansgement.. )

a

Print Setup.,

Print... Clri=F
Print Preview

1 SensorDemo_BlueMs_main.c

2 gatt db.c

3 BlusNRGL it.c

4 mems_sensors_config.c

5 zensorc

6 HandsOnlabs_CodeSnippats.brt
T hw_canfig.c .

& hw_configh

9 gatt.db.h

10 LPS25HEB ¢

“Enit




BlueNRG-2 License Installation 3/6

license Management [==T)

| Sr@ia-thwhmvm'matmmlﬁmm.m%mm FlexLM Lisanse |

- Customer Information - Computer [0
CiD:  |cBZDR1E203

Haﬁ']g'j Iﬂm H\‘H

. Comparyy:  |STMicrolestronics | e e |
Select the Single-User o [icragian
License tab and click the | e e T i |

button Get LIC via Internet...,

New License ID Code (LIC) |




BlueNRG-2 License Installation 4/6

|
Licenz= Management | &= |

Single-User License lHDahnngemeI Floating License Admiristrator | FexLM License

i T T )
Click the button OK to register j”f‘"j |

'ﬂ Youare about to register a Product and obtain a License IB Code (LIC).

t h e p rOd u Ct . — | The following information must be sent to www keil cam:

Product Senal Number (PSN)

This action opens the License MoKA ComputerID Number (CID):  CBZDR-8203
Management page on the Keil web Notes:

+ You may register the product manuslly st
S i te Rt/ fweww keil.comy/license/install.htm,
. « After registering, you will recenve an e-mail containing the UIC for
your computer,
« EntertheLIC into the New License ID Code fild,

Nawﬂ] I

Lys
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BlueNRG-2 License Installation 5/6

.
For the latest Product Serial Number
please check on the Keil website at this URL:

http://www2.keil.com/stmicroelectronics-stm32/mdk

Product Licensing Home { Product Licenging
Qverdaw
Single-User License 1 1
9 Single-User License
Single-User License Uninstall
Floating-tser License Enter your Product Senal Number (PSN) and cantact infermation using the foliowing form 1o license your Keil

product Be sure to include dashes.

Then enter the PSN in this webpage along I o 8 5 T i i o 5 o e GRS i
with your contact information and click the

button Submit.

sure any spam blocker you use is configured fo allow this address

Enter Your Contact Information Below

Computer ID (CID) cezom.2203

[ Product Serial # (PSN): ]

PC Description:

An e-mail is sent back with the License |ID S
First Name:  rafeele P

Code (LIC) within a few minutes. -

E-maill sfacie nvagdsicom

Company: ‘STMicroetsctronics
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BlueNRG-2 License Installation 6/6

License Mansgement . =]
" Single-Use Licanse: | Floating License | Foating Licsnse Administrator | FlexLM Licerise | i
—Cusiomer information Computer 1D
Neme:  |Faffacle iva O |cFW23ATCR ‘
_ Copny.  |STMisdladionics Get UCviafemet.. |
To activate the Software Product, Emal.  [lfaci va@stcon
enter the LIC you received by email hmMCbrtekMWMNZEBKTWSTl mﬁﬁﬁmmsum;ﬂﬁ:;w
in the field New License ID Code
(LIC) and click Add LIC.
. Nei me;m'cﬂda;uq-| GG MN-YHBDA-N 1280 TRENIVUTXT-SULRH Aad LIC il
Then click on Close
Cigse Help |




